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About this manual

This User Manual describes the ExG visualization software BrainVision RecView Version
1.4.3. It is part of the software product.

It is essential to follow the instructions in the manual in order to use the software correctly
and as intended.

The structure of the manual

The User Manual has 8 chapters:
» Chapter 1 contains a description of the individual installation steps.

» Chapter 2 contains instructions on how to configure RecView and the BrainVision Record-
er recording software before you can start viewing and recording data.

In Chapter 3 you will learn how to operate RecView.
Chapter 4 provides information on configuring the user-specific settings.
Chapter 5 describes the use of montages.

Chapter 6 and Chapter 7 describe all the filters that are available for RecView.

vV v v v Vv

In Chapter 8 you will find information on how to program your own filters.

Who is the manual intended for?

The current User Manual is intended for users in the psychological and neurophysiological
research area as well as physicians and medical experts.

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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18 About this manual

Conventions used in the manual

The manual uses the following typographical conventions:

italic

underscore

monospaced

Italic text is used to identify menus, menu commands, dialog boxes, but-
tons, options and the names of files and folders. Italic font is also used to
highlight portions of running text.

Underscored text indicates a cross-reference or a web address.

A monospaced font is used to indicate text or characters to be entered at
the keyboard, such as source code and programming examples.

The blue dot indicates the end of a chapter.

The manual also uses the following symbols to help you find your way around:

Personal injury: This symbol indicates that incorrect use of the devices
may result in a health hazard to the test subject, the user and/or a third-
party. Failure to observe the information in these Operating Instructions
constitutes incorrect use.

Damage to property: This symbol indicates that incorrect use of the

devices may bring about an urgent risk of damage to property.

Stop: This symbol indicates that you should not carry out a particular
action.

Cross-reference: This symbol indicates a reference to a related chapter,
section or document.

Note: This symbol draws your attention to important information relating
to the current topic.

Tip: This symbol draws your attention to recommendations on how to
use our products.

New: This symbol indicates that the Operating Instructions have been
changed or that new material has been added at this point.



Revision history

Page ....Status...... Subject

22 i changed ........ Intended Use

22 e NEW weeveeeerinnnns Correct use

23 e NEW .eeeveeerennn. Combination with other products

55 vveeeeenne NEW .eevereerennnne Linear Derivation supports frequency domain
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20 About this manual

Reporting errors and support

You can search for updates of this manual on our Web site under www.brainproducts.com/
downloads.php?kid=5&tab=2.

If you require technical support or if you discover a mistake in the manual, the software or
during operation, please contact:

Brain Products GmbH

ZeppelinstrafRe 7

D-82205 Gilching

Tel. +49 8105 73384 -0

Fax: +49 8105 73384 - 505

Web site: http://www.brainproducts.com
Email: techsup@brainproducts.com

On request, the technical support team will also send you a form to assist in clarifying faults
and problems. °


http://www.brainproducts.com/downloads.php?kid=5&tab=2
http://www.brainproducts.com/downloads.php?kid=5&tab=2

Introduction

RecView and its functions

The BrainVision Recording Viewer — referred to below as RecView — is an add-on module for
the BrainVision Recorder recording software that allows you to assess the quality of the EEG
recording. RecView allows you to process the recorded data in real-time and provides a num-
ber of Online processing filters for this purpose.

In addition to traditional signal processing filters such as the Frequency filter or the FFT filter,
RecView also provides special filters for correcting scanner and pulse artifacts for data re-
corded during combined fMRI-EEG measurements.

The Segmentation filter and Average filter allow you the option of viewing your data by seg-
ment and carrying out event-related and marker-based analyses. You can use the extended
Average filter to calculate weighted averages with various weighting functions in both the
time and frequency domains.

The FFT filter possesses configurable window functions to improve the calculation of the fre-
quency spectrum.

The LORETA filter allows you to calculate virtual channels over "regions of interest" and to use
the LORETA method to trace signals back to their sources in the various regions of the brain.

The Linear Derivation filter allows you to define new channels as linear combinations of ex-
isting channels. Alongside manual configuration, it is also possible to read the coefficient
matrix from a text file.

RecView also possesses three filters which can directly address your computer's parallel
port: The Level Trigger filter sends signals to the parallel port as a function of the voltage
curves, the R-Peak Trigger filter is a variation of the Level Trigger filter which sends signals to
the parallel port when ECG peaks are detected. The Band Power Trigger filter sends signals
depending on the characteristics of the frequency spectrum.

RecView can not only display the impedance values but also possesses an innovative func-
tion for improving the quality of your EEG recordings: The Bridge Tool filter is used to detect
gel bridges and assists you to prepare for the acquisition of EEG data using a large number
of channels.

You can daisychain filters and introduce branches to create extensive filter trees, thus allow-
ing you, forinstance, to take the output data from an MRI artifact correction and use it as the
input data for an FFT filter. Oryou can implement the Level Trigger filter after the LORETA filter
and use the voltage curve from your virtual ROl channel to control a feedback application as
part of a BCl experiment.

The modular structure of RecView allows you to expand the software to incorporate addition-
al, user-defined filters in the same way as you can for the transforms of our EEG analysis soft-
ware BrainVision Analyzer.

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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Introduction

A Personal injury

You can run RecView on the computer on which the Recorder is installed or on further com-
puters in the network. This networking capability means that you can run up to ten RecView
programs simultaneously on different computers in conjunction with just one Recorder.

Intended use

As of September 30th, 2013 and software version 1.4.3, BrainVision RecView is not a medi-
cal device anymore and may be used in the context of non-medical applications in order to
carry out fundamental or applied research on the basis of neurophysiological methodology
and data.

RecView is intended to be used for visualizing and processing electrophysiological signals
(e.g. EEG, EMG, ECG, EOG) and/or signals from other approved sensors. RecView allows ExG!
data to be viewed concurrently while it is being recorded using the ExG recording software
Recorder and is only to be used in conjunction with the Recorder.

Use of the RecView for diagnosis, therapy, monitoring of vital life functions (such as cardio-
vascular functions etc.) or other medical purposes is expressly forbidden.

The user is solely liable for any risks to test subjects associated with the investigation if the
software is not used in accordance with the correct use described. Brain Products GmbH pro-
vides no guarantee and accepts no liability for the results obtained with RecView.

Correct use

BrainVision RecView is permitted to be used by users in the psychological and neurophysio-
logical research area as well as physicians and medical experts.

BrainVision RecView is not permitted to be used by
» unqualified persons (e.g. laymen),

» people who personally cannot read or understand the User Manual (e.g. due to insuffi-
cient language knowledge, due to blindness).

BrainVision RecView can be used to view and filter neuro-/electrophysiological signals from
healthy and sick adults, children and animals

Irrespective of any liability on our part, the specialist staff must observe the relevant national
stipulations for operators and other relevant national legislation.

If you record EEG/EXG signals in an MR scanner, the computer must always be positioned
and used outside the scanner room.

1. EEG, EOG, ECG, EMG, EDA, etc.



Allversions of BrainVision RecView that have been released into the market as medical prod-
ucts do remain medical products. Brain Products will continue to treat them as medical prod-
ucts (i.e. to perform post market surveillance, for example) until the end of their service life.

The user should be aware that if a former BrainVision RecView version that was a medical
productis replaced by a newer version that is not a medical product anymore, the terms and
conditions of the new BrainVision RecView version are effective only from then on.

Use together with other products and components

BrainVision RecView is foreseen by the manufacturer to be combined with BrainVision Re-
corder. ®
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Chapter 1 Installation

Under normal conditions, RecView does not cause any conflicts with other programs that are <9
already installed. Brain Products GmbH, however, only guarantees that programs will inter-

act without problems if the programs concerned have been tested for compatibility. This ap-

plies to the EEG analysis software BrainVision Analyzer and to the Microsoft operating
systems Windows® XP, Windows® Vista, Windows® 7 and Windows® 8 provided that no
modifications to the configuration of the operating system as delivered have been undertak-

en (including official service packs and updates).

To use RecView, you must have installed the recording software BrainVision Recorder Ver-  General conditions
sion 1.10 or later on your computer and you must possess a license for RecView.

If you are using additional computers, you must ensure that there is a TCP/IP network con-

nection between the computers.

The system has the following hardware and software requirements: System requirements

» Operating system: Windows® XP Service Pack 3 or later, Windows® Vista Service Pack
1, Windows® 7, Windows® 8.

» Minimum configuration: Intel Pentium IV, 2 GHz processor or higher, 512 MB of RAM,
graphics card with 64 MB of RAM.

» Minimum 1 GB free hard disk space. Additional storage requirements depend on the ex-
tent of the data to be processed.

» We recommend a monitor with a screen diagonal of at least 17". For more than 32 chan-
nels, you should use a 21" monitor.

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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26 Chapter1 Installation

1.1  Installing RecView under Windows® XP

Proceed as follows to carry out installation under Windows® XP:

1 Start Windows® XP.

Please make sure that you 2 Insert the supplied BrainVision program DVD into your CD-ROM drive.

possess the most recent

RecView program version — 3 If your computer is set up to autostart a CD-ROM, the menu that guides you through the
including any updates. You installation will appear after a short time. If your computer is not set up to autostart CD-
can check whether a more ROMs, you must run the installation program manually. Proceed as follows:

recent version is available

on our Web site at http:// a From the taskbar, choose Start » Run.

www.brainproducts.com/

down- a Click the Browse button.

loads.php?kid=3&tab=1.

b Inthe Browse dialog box, select your CD-ROM drive and double-click the Autorun.exe
file to open it.

4 Follow the instructions displayed. The installation process that follows is described in
<% section 1.2, step 5 as of page 28.

After successful installation of ~ Connect the USB dongle of BrainVision to one of the USB ports of your computer before you
RecView and the required soft-  start the RecView. Start RecView by double-clicking the RecView shortcut @@5, which you will
ware components find on your desktop after installation has been completed successfully.


http://www.brainproducts.com/downloads.php?kid=3&tab=1
http://www.brainproducts.com/downloads.php?kid=3&tab=1
http://www.brainproducts.com/downloads.php?kid=3&tab=1
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1.2 Installing RecView under Windows® Vista, Windows® 7
and Windows® 8

Proceed as follows to carry out installation under Windows® Vista/Windows® 7/
Windows® 8:

1 Start Windows® Vista/Windows® 7/Windows® 8.

2 Insertthe supplied BrainVision program DVD into your CD-ROM drive. Please make sure that you
* possess the most recent
3 |Ifyourcomputeris set up to autostart a CD-ROM, then the AutoPlay dialog box opens au- RecView program version —
tomatically after a short period. Click Run Autorun.exe (see Figure 1-1). In this case, skip including any updates. You

can check whether a more
recent version is available

) . ) ) ) on our Web site at http://
Figure 1-1. AutoPlay dialog box for Windows® Vista/Windows® 7 www.brainproducts.com/

- - — M down-
© avoriey [ o - - loads.php?kid=3&tab=1.

/6\ DVD RW Drive (E) 100309_1642

[7] Always do this for software and games:

step 4 and continue with step on page 28 of these installation instructions.

Install or run pregram frem vour media

'E’m‘ Run Autorun.exe H

; Publisher not

General options

Open folder to view files
J using Windows Explorer

View more AutoPlay options in Control Panel

4 If your computer is not set up to autostart CD-ROMs, you will have to run the installation
file manually. Proceed as follows:

a Clickthe Start@ button on the taskbar and then choose All Programs > Accessories

> Run (see Figure 1-2).
Alternatively, you can press the Windows key (ﬂ) +R.

¢ Inthe Run dialog box, click Browse... and select the CD-ROM drive.
d Double-click the file Autorun.exe to open it.

e Click OKin the Run dialog box (see Figure 1-3).


http://www.brainproducts.com/downloads.php?kid=3&tab=1
http://www.brainproducts.com/downloads.php?kid=3&tab=1
http://www.brainproducts.com/downloads.php?kid=3&tab=1
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Figure 1-2. Executing the Autorun file under Windows® Vista/Windows® 7 (A)

| Accessories
Calculator
B Command Prompt
@2 Connect te a Network Projector
B Connect to a Projector Documents
=1 Getting Started
& Math Input Panel Pictures
j Notepad
Ifsf Paint Music

Run [ Games
R snipping 1ool

'_, Sound Recorder
I Sticky Motes

@ Sync Center

1 Windows Explorer
WordPad

J Easeof Access Default Programs
)i System Tools

1. Tablet PC Help and Support

Computer

Control Panel

Devices and Printers

Back

| Search programs and files

Figure 1-3. Executing the Autorun file under Windows® Vista/Windows® 7/Windows® 8
(B)

T T

= Type the name of a program, folder, document, or Internet

— resource, and Windows will open it for you.

Open: Ef\Autorun.exe -

[ o %J[ Cancel H T

5 When the installation file is run, the Welcome to BrainVision Installation dialog box is
displayed. Click Install BrainVision RecView (see Figure 1-4). The second page of the
BrainVision RecView dialog opens.



Figure 1-4. Selecting the software to be installed
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(o]

@ Product Manuals

@ Demo Data

@ Install further Components
tder & Browse the CD

BRAIN PRODUCTS

Solutions for neurophysiological research

BRAINGISION

@ Welcome to BrainVision Installation
Welcome to BrainVision Installation
@ What would you like to do?
& @ Install BrainVision Analyzer 2
@ Install BrainVision Recorder
& Install E@n\/ﬁsbn RecView
Register your Product online
BRA]N@ISIDN BRA]NE]S!BN
ANALYZER™® RECORDER
Copyright ® Brain Products GmbH - 7 - 82205 Gilching - Germany

6 You require Microsoft .NET Framework Version 4.0 or later to be able to use RecView. If

Microsoft .NET Framework

this runtime environment is not present on your computer, click /nstall .NET 4 on the sec-

ond page of the dialog (see Figure 1-5).

Figure 1-5. Installing Microsoft .NET Framework Version 4.0 (second page of the installation

dialog)

-
@ BrainVision RecView

==

& Please choose from the options below

- @ Install RecView Software (requires NET £

[V] fnsta.'FETtJ
[J Upen Manual (Engnsh Version)

@ Open Manual {(German Version)

_
BRAIN@ISION

ANALYZER®

BRAIN@ISION

RECORDER

BRAIN PRODUCTS

Solutions for neurophysiological research

BRAIN@ISION

Copyright © Brain Products GmbH - 7 - 82205 Gilehing - Germany

7 The system asks you if you want to authorize installation of Microsoft .NET Framework

Version 4.0. Click Yes (see Figure 1-6).
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Figure 1-6. Confirmation query before installing Microsoft .Net Framework Version 4.0

% Program name:  dotMNetFud0_Full_«86_x64.exe

Verified publisher: Microsoft Corporation
File erigin: CD/DVD drive

(%) Show details [ ves s

|
Change when these notifications appear

8 You must accept the applicable license agreement before you can continue with the in-
stallation of Microsoft .NET Framework Version 4.0. After doing this, click /nstall in the
Microsoft .NET Framework 4 — Setup dialog box (see Figure 1-7).

If you are asked to do so, reboot your computer.

Figure 1-7. Accepting the Microsoft .NET Framework Version 4.0 license agreement

e

m . Microsoft NET Framework 4 Setup

&

| § for neurophysiological research

.NET Framework 4 Setup
Please accept the license terms to continue. Mirasofr

MICROSOFT SOFTWARE
SUPPLEMENTAL LICENSE TERMS

%'ﬂverﬁdmaﬂmptw license terms ;

Download size estimate: 0MB
Download tme estimates: DialUp: 0 minutes
Broadband: 0 minutes

BRAIN@ISION BRAIN@ISION BRAINGJISION

vorer ANALYZER® peieor RECORDER o RECVIEW

Copyright @ Brain Produets GmbH - Zeppelinstrasse 7 - 82203 Gilching - Germany

9 When Microsoft .NET Framework Version 4.0 has been successfully installed, click Install
RecView Software on the second page of the installation dialog (see Figure 1-8).
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Figure 1-8. Installing RecView (second page of the installation dialog)

Ef BrainVision RecView

BRA

Solutions

CE

Please choose from the options below

@ Instalf RecVa'e@omvare equires NET 4

. L P | T i el |
OV Ll e ) s

@ Open Manual (English Version)

@ Open Manual (German Version)

If Microsoft .NET Framework 4.0 is not present on your system, then the following mes- <)
sage is output here (see Figure 1-9) and the installation procedure is aborted.

Figure 1-9. Error message output if NET Framework Version 4.0 is not present

F B
ﬁ BrainVision RecView 1.4 Setup ﬁ

y BrainVision RecView 1.4 requires .NET Framework 4 or
J‘_\‘ higher. Please install .MET Framework 4 before running
~ this Setup again. .NET 4 can be obtained from the

BrainVision program CD or following the download link on
the Brain Products web site.

10 The BrainVision RecView 1.4.2 "Setup" dialog box opens. Click Next (see Figure 1-10).
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Figure 1-10. "BrainVision RecView 1.4.2 Setup" dialog box

-
o 1) BrainVision RecView 1.4.2 Setup =] = EZRAIN PI
itions for neuropl
Welcome to the BrainVision RecView
1.4.2 Setup Wizard

The Setup Wizard will install BrainVision RecView 1.4.2 on
your computer, Click Next to continue or Cancel to exit the
Setup Wizard.

ents

Back Next_DeJ | Cancel J

11 To continue with the RecView installation, you must accept the applicable license agree-
ment. Click Next (see Figure 1-11).

Figure 1-11. Accepting the RecView license agreement

E’—,J BrainVision RecView 1.4.2 Setup = IEI iRAl N P|
lutions for neuroj
End-User License Agreement
Please read the following license agreement carefully S S

Licensing Terms -

1. Scope of validity and subject of the agreement

The following terms apply to the provision and use of the

computer program "BrainVision RecView" developed by Brain
Products GmbH (referred to hereinafter as "Brain Products"),

the user documentation (user manual) and any other associated
written material as well as all copies, updates, upgrades and any _

kb ol ol o e il i s D Dl il il sk sslbialks

ents

[¥]1 accept the terms in the License Agreement |

Pint | [ Back | Mext_%dl [ cancel

12 You select the program folder for RecView during installation (see Figure 1-12).
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Figure 1-12. Selecting the program folder

Destination Folder
Click Next to install to the default folder or dick Change to choose another.

Install BrainVision Reciew 1.4.2 to:

IC:‘\\ﬁsionWac\ﬁew\

13 The system asks you if you really want to perform the installation. A user account control
dialog box appears. Accept the installation (see Figure 1-13).

Figure 1-13. Security query under Windows® 7 and Windows® 8

Program name:  RecView.msi
Verified publisher: Brain Products GmbH

File origin: Hard drive on this computer

14 Follow the installation instructions which are now displayed until installation is complet-
ed.
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After successfuliinstallation of ~ Connect the supplied USB dongle to one of the USB ports of your computer before you start

RecView and the required soft-  RecView. Start RecView by double-clicking the RecView shortcut &% , which you will find on

ware components your desktop after installation has been completed successfully. )



Chapter 2 Configuring the software

2.1 Installing the RecView license

Install the license for RecView on the computer on which you are running the Recorder.

The license file is on the USB data medium accompanying the BrainVision program DVD (see
Figure 2-1).

Figure 2-1. RecView license on the supplied USB data medium

(=N | B =50
f-‘-\ i - L D Ex T
u@v|- » Com... » Removable ... - | ¢,| Search Removable Disk (D:) R |
Organize » Share with « Burn Mew folder 4=z - m -@n
Mame - Type

- Favorites
| BrainProducts-License-20130115-1110.exe  Application
4 Libraries

1% Computer
£, Windows7_05 (C:)
e Removable Disk (D:)

1 item

Proceed as follows:
1 Unpackthe ZIP file BrainProducts-License-xxxxxxx-xxxx.zip.

2 Runthe EXE file BrainProducts-License-xxxooxx-xxxx.exe by double-clicking it. Follow the
instructions from the installation program.
On systems running Windows® Vista/Windows® 7, always run the file by right-clicking
it and choosing Run as administrator (see Figure 2-2).

Figure 2-2. Running the license file as administrator under Windows® 7

=5 ol >
Q@v|_ » Com.. » Removable .. - | $¢| | Search Removable Disk (D:) jo |
Organize « Share with = Burn Mew folder =« [ l@l
MName ’ Type

. Favorites

[Zi BrainProducts-License-20130115-1110.exe Application

4 Libraries Open
'E-,f' Run as administrator Ih
1M Computer
£, Windows7_05 (C) Sy 2
e Removable Disk (D:) Cut
e Copy k
1 item Create shortcut
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Alternatively, you can obtain
the most recent license file
from the Brain Products Web
site. For detailed informa-
tion, refer to Appendix B as of
page 141.
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3 Then connect the USB dongle supplied with the BrainVision program DVD to one of the
USB ports of your computer.

To check whether you have a dongle with a RecView license, start the Recorder and choose
Help > About BrainVision Recorder... from the menu (see Figure 2-3).

Figure 2-3. Calling Recorder program information

File View DisplayMontage Amplifier Configuration Window [Help |

oo | L o «f 0] Q& 2f—|=|=|v]a| Comen
Show Installed Components...
About BrainVision Recorder...

If you have a suitable USB dongle, the line Vision RecView is shown under Sub-licenses (see
Figure 2-4).

Figure 2-4. Displaying sub-licenses in the Recorder

|1 Eilesvicnms DisplayMontagemAmi|

= q
| D | Fl'ml ’l "l .l gl ! #~=.  Brainvizion Recorder Yersion 1.20.0506
o Copyright® 2000 - 2013 Brain Products GmbH Systern Info |

Hazp HL 5/N: 106121 [Analyzer/Recorder combined dongle] a
Dongle Expiration Date: Unlimited
Sublicenses: H

Wizion Widen

Wision RecView

BDF File Format

-

Maote: If a sublicense has expired, please contact your local dealer or aur support
at techzup{@brainproducts. com.




2.2  Configuring the Recorder

To start RecView,activate the Remote Data Access server (RDA server) in the Recorder.

1 To do this, choose Configuration > Preferences... from the menu (see Figure 2-5).
2 Inthe Preferences dialog box, open the Remote Data Access tab.

3 Checkthe Enable Remote Data Access box (see Figure 2-6).

Figure 2-5. "Preferences" in the Recorder menu

File View Display Montage Amplifier |

@l i |"|_|'|_[| ’l "| .I gl al@l| Select Folder for Worldfiles...
Predefined Annotations...

Preferences...

Select Amplifier...
Select Data Storage Type...

Administrator...

Figure 2-6. Activating the RDA server in the Recorder

File View Display Montage

®lo|w| [l m“;'dmn =
I e Data Vision Video

¥ Enable Remote Data Access

Display program infor
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<@ You will find detailed infor-
mation on using the Re-
corder in the associated
User Manual.
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While it is being displayed, the EEG data can now be passed via TCP/IP to other programs on
the local computer and to computers in a network.

The RDA server of the Recorder uses the TCP/IP ports with the port numbers 51234 and
51244. If you are running a firewall on your computer, it will issue a message when you acti-
vate the RDA server. You can specify that the Recorder software should no longer be blocked
(see Figure 2-7). Alternatively, some firewalls allow you to enable TCP/IP ports 51234 and
51244 explicitly. “@= For further details, refer to the user documentation for your firewall soft-
ware.

Figure 2-7. Unblocking the Recorder software

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of Recorder on all public and private netwaorks.

A Mame:
0 Publisher: Unknown

Path: C:\wision\recorder yrecorder .exe

Allow Recorder to communicate on these networks:
[ Private networks, such as my home or wark network

networks, such as those in airports and coffee shops {(not recommended
use these networks often have litte or no security)

What are the risks of allowing a program through a firewall?




2.3  Configuring RecView

Proceed as follows to configure RecView for the data view:

1 Start RecView by double-clicking the RecView shortcut @, which you will find on your
desktop after installation has been completed successfully.
Alternatively, you can call RecView from the task bar (Windows® XP) or the Start @ but-
ton (Windows® Vista/Windows® 7) by choosing Start » BrainVision RecView.

2 You must now specify what computer in the network the Recorder is running on. To do

this, choose Configuration » Server... from the RecView menu (see Figure 2-1). The Serv-
er dialog box appears.

3 Here you enter either the IP address or the computer name (see Figure 2-8).

Abbildung 2-1. Calling the "Server" dialog box

-
E BrainVision RecView

File Display Montage | Configuration | Window Help

i Ql Ql Select Folder for Workfiles...
Server. Strg+Umschalttaste+5
Master Filter... b Strg+Umschalttaste+ M

Filter Tree... Strg+Umschalttaste+F
Preferences... Strg+ Umschalttaste+ P
LPT Port Address...

Figure 2-8. Entering the server name

Ef BrainVision RecView

File Display Montage Configuration Window Help

Enter the name of the computer where the Vision
Recorder runs. Alternatively enter the |F address:

IIocthosﬂ

0K I Cancel

If a version of the Recorder is already installed locally on the computer, RecView takes the
folder specified for work files from this installation. This folder is known as the Work Files
folder. The work files include the workspaces and montages.
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- Ifthe Recorder is on the lo-

cal computer, enter the IP
address 127.0.0.1 or the
name "localhost".
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Creating a new Work Files fold-
er

Specifying the LPT port ad-
dress

To create a new Work Files folder, choose Configuration > Select Folder for Workfiles... and
then select the required folder (see Figure 2-9 and Figure 2-10).

Figure 2-9. Calling the dialog box for selecting the Work Files folder

’E—; BrainVision RecView
File Display Montage E{mﬁguﬁhm | Window Help
Ql Ql Select Folder for Workfiles..,
Server.. Strg+Umschalttaste+5
Master Filter... Strg+Umschalttaste+ M
Filter Tree... Strg+ Umschalttaste+F
Preferences... Strg+Umschalttaste+ P
LPT Port Address...

Figure 2-10. Selecting the Work Files folder

Select Folder for Workfiles

Bl Desktop
I [ Libraries
4 j User
28 Computer
4 &, Windows7_05 (C)
> @ Documents and Settings
b | PerfLogs
> | Program Files
4 || Vision
4 || RecView
| Anatomies

[ ok [ cancl

If you want to use afilter with parallel port control, you must specify the LPT port address:

1 To do this, choose Configuration > LPT Port Address... from the menu (refer to Figure 2-
11).

2 Enter the LPT port address in the text box Hardware Address of LPT Port (hex) (see

Figure 2-12).
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Figure 2-11. Calling the dialog box to enter the LPT port address @ For information on identify-
ing the LPT port address,
@ BrainVision RecView refer to Appendix C on
File Display Montage | Configuration | Windew Help page 145.

Ql Ql Select Folder for Workfiles...

Server. Strg+ Umschalttaste+5
Master Filter... Strg+Umschalttaste+ M
Filter Tree... Strg+Umschalttaste+F

Preferences... Strg+ Umschalttaste+ P
LPT Port Address... [

Figure 2-12. Entering the address of the LPT port

Ef BrainVision RecView

File Display Montage Configuration Window Help
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Chapter 3 Getting started and handling the program

3.1 The user interface

The menu bar and the toolbar are located at the top of the RecView window.

Figure 3-1. Menu bar and toolbar

"/ BrainVision RecView EI@I

|Fi|e Display Montage  Configuration  Window  Help |(—

2| ala| Alel=[ElvIalt- @ 2l|=I=]v]al

FP‘T WMWWWWMWM el g
100 pv

ot b g poen o g ey
100 pv

F3 T R R P R L R T L T et Tt A o g
100 v

Fia I O T Tt g o i W Pttt g S ol b L f o0
100 v

C3I A PR 1 0 AP P e M Mt A el TP At Nt Py P A
100 v

u[ B AR AR WS S W TR BT A
100 v

Rear..huﬂ Freq.uem Freq.uent nt Freq.uem Freq.uem lRea::Ilun Freq.uem
Mornitoring Standard Mortage Blocks Ok 2131AAB_HC <None>
The individual menus have the following functions: Menu bar
Menu Description
File is used to set up, edit and save a workspace.

Display Montage is used to display the montages.

Configuration is used to make default settings for the locations used to archive
and store the work files and the data and to configure the filters and
user settings.

Window is used to organize the data windows.

Help is used to display program information and the installed compo-
nents and to open this User Manual.

The main toolbaris located below the menu barand allows you to make a number of different  Toolbar

settings, including the displayed interval and the number of channels displayed simultane-
ously.

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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The labels for the elements in the main toolbar are displayed when you position the mouse

pointerover each element. Atool tip appears after afew moments. The main toolbar contains

the following elements. They refer to the main window (left-hand window):

[l e F

>

[

Description

Connect to Vision Recorder
Disconnect from Vision
Recorder

Increase Interval

Decrease Interval:

Scale Up

Scale Down

Decrease Channels
Increase Channels

Next Channel Group

Previous Channel Group

Baseline Correction in Display

Reset Averaging Templates

establishes the connection to the Recorder

interrupts the connection to the Recorder

increases the displayed interval (alternatively,
use the keyboard shortcut Ctrl + Num-)

decreases the displayed interval (alternatively,
use the keyboard shortcut Ctrl + Num+)

increases the scale (alternatively, use Ctrl +
arrow up)

decreases the scale (alternatively, use Ctrl +
arrow down)

decreases the number of channels displayed
increases the number of channels displayed

switches to the next channel group (alterna-
tively, use Ctrl + page down). This function is
only available if you have previously reduced
the number of channels.

switches to the previous channel group (alterna-
tively, use Ctrl + page up). This function is only
available if you have previously reduced the
number of channels.

activates or deactivates baseline correction.
Only the baseline of the display is changed, not
the data itself.

used to recalculate the correction templates for
MRI artifact correction during filtering. This but-
ton is only available for MRI artifact correction
and is only visible when this filter is active (see

also “% Section 7.1 as of page 121).

At the top right of the RecView window is another toolbar that applies to the currently active
filter window (right-hand window). This contains the following buttons:

M Scale Up, ﬂ Scale Down,

ﬂ Decrease Channels, @ Increase Channels,



ﬂ Next Group, H Previous Group and ﬂ Baseline Correction in Display.

Their functions and keyboard shortcuts are the same as those of the main toolbar. However,
note that you have to press the key combination Ctrl + Shift rather than just the Ctrl key to
use the keyboard shortcuts.

The status bar at the bottom of the RecView window is made up of the following sections:

Monitoring

The first section shows the current status of the program (Not Connect-

[

ed, Connected, Monitoring, Impedance Check, etc.).

Standard Mot . .
it The second section shows the type of montage used. For further infor-

mation on montages, refer to < Chapter 5 as of page 75.

et bl The third section (block indicator) shows whether the data blocks sent

to RecView by the Recorder have been completely processed ("Blocks Ok") orwhether blocks

have been lost during data transfer ("Blocks Lost!"). Data may be lost during transfer if
RecView is unable to accept the data in time due to high loads.

Standard Workspace . .
= The fourth section contains the name of the current workspace. For fur-

ther information on workspaces, see < Section 3.5 as of page 62.

Fi Fitt . . .
il il The fifth section shows the employed master filter. If you have not se-

lected a masterfilter, the status bar displays the entry <None> here. Forinformation on select-
ing a master filter, refer to “ Section 3.3 as of page 52.

0378
! 2=2°2=°°°°% | If you use a filter with parallel port control (Level Trigger, Band

Power Trigger, R-Peak Trigger) then the sixth section of the status bar contains a graphic dis-
play of the status of the LPT port's eight data lines. Red stands for the status "high" and black
for the status "low". Please note that TTL pulses that are reset immediately are not visible in
the status bar.

To be able to use the filter with parallel port control, you must specify the address of the LPT
port. To do this, choose Configuration > LPT Port Address... from the menu.

The main window (left) shows the data sent by the Recorder. The filter window (right-hand
section of the RecView window) contains the filters selected by the user (see Figure 3-2).
Tabs allow you to switch between the individual filters (see Figure 3-3).
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Status bar

For information on identify-
ing the LPT port address,

refer to Appendix C on
page 145.

You will find detailed infor-
mation on creating a filter
tree in Section 3.4 as of

page 53.
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Figure 3-2. RecView interface
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Figure 3-3. Tabs for switching between filter windows
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The channel names are shown on the far left of the RecView window. At the end of the chan-
nel list, there is a scaling bar (see Figure 3-4). The scaling bar is used to assess the signal
size. If a small number of channels are displayed and there is enough space, a scaling bar is
shown in front of every channel (see Figure 3-5).

Figure 3-4. Scaling bar at the end of the channel list
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Figure 3-5. Scaling bar display in front of each channel
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Beneath the channel list, separated by a gray line, the program displays any markers present
in the EEG (see Figure 3-6).



48 Chapter 3 Getting started and handling the program

Figure 3-6. Markers displayed
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3.2 Performing a simple session

Proceed as follows to test the basic functionalities of RecView:

5

Once it has been successfully installed and configured, start the Recorder.
Start RecView.

In the RecView toolbar, click Connect to Vision Recorder ' |. This establishes the con-
nection between the Recorderand RecView. Ifthe Recorderis not available, the message:
Waiting for Recorder... appears in RecView.

Start the Recorder in monitoring mode by clicking the Monitor button <§>| (see Figure 3-
7).

RecView now also displays the data sent by the Recorder (see Figure 3-8).

Figure 3-7. Starting data viewing/recording in the Recorder
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Figure 3-8. Simultaneous data view in the Recorder and RecView
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You can select individual channel mode (see Figure 3-9) by double-clicking the name of the  Individual channel mode
required channel. Double-clicking on this view in turn switches back to the overall view.

Figure 3-9. Individual channel mode

. M /\W\/\

2y




50 Chapter3 Getting started and handling the program

Activating/deactivating chan-
nels

It may, for instance, be sen-
sible to deactivate chan-
nels if heavy interference
on one channel hides other
channels.

Impedance view

To deactivate a channel and thus suppress the signal received, right-click the corresponding
channel name. This opens a context menu. Choose Switch Off ‘channel name' Locally to de-
activate the channel in the active data window. Choose Switch Off ‘channel name' Globally
to deactivate the channelin all open data windows. To reactivate the channel, repeat the pro-
cess and click the relevant menu item to remove the tick in front of the command.

Figure 3-10. Global deactivation of a channel
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Figure 3-11. The VEOG channel has been deactivated globally and the HEOG channel locally
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If you switch the Recorder to impedance mode, RecView also displays the impedances of the
electrodes (see Figure 3-12).



Figure 3-12. Impedance mode in the Recorder and impedance view in RecView
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<@ For details on the combina-

tions of filters that are per-
missible in the filter tree,
refer to section 4.4 on

page 55.
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3.3 Selecting a master filter

To make the following settings, disconnect RecView from the Recorder. To do this, click Dis-
connect from Vision Recorderil in the RecView toolbar.

If you wish, you can select a master filter. The masterfilter is used to filter the raw data sent
by the Recorder before it is displayed in the main RecView window. The data is also pre-fil-
tered before it is passed to all the other RecView filters.

You can replace the master filter at any time, e.g. even after you have created a filter tree. It
is not, however, possible to use every filter as a master filter. The Average filter, for example,
requires segmented data and can therefore not be applied to raw data.

Filters that can typically be used to good effect are the MRI artifact filter and the Frequency
filter.

To open the dialog box for selecting a master filter, choose Configuration > Master Filter...
from the menu (see Figure 3-13).

Figure 3-13. Dialog box for selecting the master filter
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To configure the master filter, click the Parameters... button. You will find detailed informa-
tion on the filter-specific parameters in @ Chapter 6 and Chapter 7.




3.4 Constructing a filter tree

The filter tree permits sequential processing of the data. It also provides the possibility of

branching.

It is not always necessary to use a filter tree. If, for instance, you only want to use the MRI

artifact filter, you can choose it as the master filter.

To open the dialog box for creating a filter tree, choose Configuration » Filter Tree... from the
menu. The Filter Tree dialog box is divided into two main windows (see Figure 3-14).

The left-hand window contains the filters installed in RecView. The filters are represented us-

ing different colored icons.

Figure 3-14. Empty filter tree
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<@ For information on select-
ing a master filter, see
Section 3.3 on page 52.
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Parameters:
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You create afilter tree by dragging filters from the left-hand window and dropping them in the
right-hand window. You can also attach filters to the branches (filter icons) in the filter tree
and thus add subnodes to the main filter nodes (see Figure 3-15).

Figure 3-15. Adding subnodes to main filter nodes by means of drag-and-drop
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Certain filters can only handle specific input data. This means that certain combinations of
filters are not possible (for more information, see Table 3-1 on page 55). If the output data
type of a filter is not compatible with the input data type of the filter to be attached, it is not
possible to chain these filters, thus avoiding interference. This is indicated by a prohibition
icon. For example, you cannot attach a Frequency filter (input data type: time domain, real)
to an FFT (output data type: frequency domain, complex) (see Figure 3-16).

Figure 3-16. Invalid filter combination: Frequency filter attached to FFT filter
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Filters can only ever be combined if their data types and segmentation types are compatible.

Table 3-1 contains all the permitted filter combinations.

Table 3-1. Combinations in the filter tree

Filter Input data type | Output data Input Output
type segmentation | segmentation
type type
Average Time domain, Same as input Segmented Segmented
frequency do- data type
main, complex
Band Power Trig- | Frequency - Segmented -
ger domain, com-
plex
Bipolar Montage | Time domain Time domain Continuous, Corresponds to
segmented input segmenta-
tion type
Bridge Tool Time domain - Continuous -
FFT Time domain Frequency Continuous, Segmented
domain, com- segmented
plex
Frequency filter | Time domain Time domain Continuous Continuous
Level Trigger Time domain Time domain Continuous Continuous
Linear Time domain, Same as input Continuous, Corresponds to
Derivation frequency data type segmented input segmenta-
domain, com- tion type
plex
LORETA Time domain Time domain Continuous, Corresponds to
segmented input segmenta-
tion type
Map Time domain, Same as input Continuous, Corresponds to
frequency data type segmented input segmenta-
domain, com- tion type
plex
R-Peak Trigger Time domain Time domain Continuous Continuous
Segmentation Time domain Time domain Continuous Segmented
MRI Filter Time domain Time domain Continuous Continuous
Pulse-artifact Time domain Time domain Continuous Continuous

Filter

The Filter Tree dialog box contains details on the currently selected filter below the two main
windows. These details include the filter name, the filter type, a brief description of the filter
and the filter-specific parameters that have been set (see Figure 3-17).
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Combinations in the filter tree
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Figure 3-17. Details on the currently selected filter
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4

@ Youwill find detailed infor-  To change the parameters of a filter, right click the icon for this filter in the filter tree. This

mation on the filter-specif-  pens a context menu. Choose Parameters... from the menu (see Figure 3-18).
ic parameters in Chapter 6

and Chapter 7. Alternatively, you can open the Parameters dialog box when you drag and drop a filter icon
to the filter tree and/or when you double-click the corresponding filter node in the tree. You
will find information on configuring these options in the description of the user settings (see
also “% Section 4.6 on page 74).




Figure 3-18. Context menu for filters
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The context menu contains the following functions in addition to Parameters...:

» You can use Cutto cut a filter from the filter tree.

You can use Copy to copy a filter node.

>
» You can use Paste to insert the filter at the required position in the filter tree.
>

Delete deletes a filter node (alternatively, you can select the filter you wish to delete and

press <Dely).

» Rename renames a filter node (alternatively, you can select the filter you wish to rename

and press <F2).

» Use Expand All and Collapse All to expand and collapse all the filter nodes.

» Choose Invisible when Filtering if you want to use a filter in the filter tree, but do not wish
to display the data. The names of invisible filters are shown in blue in the filter tree (see

Figure 3-19).

Figure 3-19. Invisible LORETA filter
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You must possess administrator privileges in order to use filters with LPT port control (Band
Power Trigger, Level Trigger and R-Peak Trigger).
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Context menu for filters

The function Invisible
when Filtering can, for ex-
ample, be of use if you want
to use intermediate filters.

Using LPT port control
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<@ For information on other
ways of running the pro-
gram as administrator, re-
fer to the Windows® user
documentation.

Under Windows® Vista and Windows® 7, you must start RecView in Administrator mode
even if you are already logged in as administrator at the computer. To run RecView as admin-
istrator, navigate to the RecView program folder, right-click the application RecView.exe and
choose Run as administrator (see Figure 3-20).

Figure 3-20. Right-clicking to run RecView as administrator
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Otherwise, an error message is output and RecView terminates monitoring mode (see
Figure 3-21). All the other filters in the filter tree may nevertheless continue to run in the
background after you have closed this error message.

Figure 3-21. Example error message from the Level Trigger filter if the LPT port address is
not specified
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When you have completed the editing steps described here, click Connect to Vision Recorder
ﬂ to establish a connection between RecView and the Recorder. Start the data view in the
Recorder by clicking Monitor “&|.

The RecView interface is now divided into two parts (see Figure 3-22): The main window (on
the left) shows the data sent by the Recorder. A master filter may have been applied to this



data. Depending on the number of filter nodes created, the right-hand side of the interface
contains one or more filter windows. This means that each visible filter node in the filter tree

has its own data window.

Figure 3-22. Data representation with a filter tree
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You can change the ratio between the main window (on the left) and the other filter windows
by dragging the split bar between the windows to the left or right with the mouse.

The tabs below the filter windows allow you to switch between the individual filter windows
(see Figure 3-3 on page 47).

You can change the arrangement of the filter windows using the Window menu (see Figure 3-
23):

» Cascade cascades all the open filter windows one after another.
» Tile Horizontally arranges the windows one above the other.

» Tile Vertically arranges the windows next to each other.

Figure 3-23. Functions for arranging the filter windows
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SC"iP.tiO“ of thf RecV'iew window. The functions and keyboard shortcuts corresponding to these buttons are the same
::irflnate:fzge in Section 3.1 as those of the main toolbar. However, note that you have to press the key combination «Ctrl-
as of page 45.

Shift> rather than just the <Ctrl> key to use the keyboard shortcuts.

Ifthe error message Window too small for display appears, enlarge the relevant filter window
with the mouse until the data is displayed correctly (see Figure 3-24).



Figure 3-24.

Enlarging the data window to show the data correctly
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3.5 The workspace concept

The filtertree you create is saved in a workspace. When RecView is first installed, a new work-
space is automatically created with the name "Standard Workspace". Any changes you make
to the filter tree are always saved in the current workspace.

If you want to define different filter trees, you must set up new workspaces:

1 To do this, choose File » New Workspace from the menu (see Figure 3-25).
2 The Save As dialog box appears.

3 Entera meaningful name for the workspace in the File name text box.

4 Click Save when you have completed your entries (see Figure 3-26).

Figure 3-25. Creating a new workspace
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Figure 3-26. Saving the new workspace
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5 The newly created workspace is now the current workspace (see Figure 3-27). It has taken
over the settings of the previous workspace.

Figure 3-27. Newly created "BrainVision1" workspace
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When you exit RecView a prompt will ask, if you want to save or discard the changes in the
filter tree.

You load an existing workspace by choosing File » Load Workspace... from the menu (see
Figure 3-28).

The workspace concept
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2

Figure 3-28. Loading an existing workspace
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3.6 Command line parameters

Avery convenient method for users who manage several workspaces at a time, is to load the
desired workspace via a shortcut-icon. With this quick access functionality you can open
RecView with the correct workspace and other parameters loaded. For each workspace you

can create a separate shortcut.

To use this function do the following:

» Openthe RecView directory.

» Right-click on file RecView.exe and select Send to » Desktop (create shortcut) (Figure 3-

29).

Figure 3-29. Create shortcut on the Windows-Desktop
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» The new shortcut-icon usually has the name RecView.exe - Shortcut.
You can rename this shortcut.
» Right-click on the shortcut and choose Properties (Figure 3-30).

Figure 3-30. Open the shortcut properties
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» Click on the tab Shortcut.

Inthe field Target you can add one or a combination of the following commands (see also
Figure 3-31):

Command Description and example

[Workspace=... Specifies the path to the workspace, e.g.
/Workspace=C:\Vision\Workfiles\2131AAB HC.rvwksp

If the path contains spaces, then use quotation marks:
/Workspace="C:\Vision\Workfiles\2131 AAB HC.rvwksp"“

/Server=... Specifies the IP-address or PC-name where BrainVision Recorder is run-
ning, e.g.
/Server=localhost

/Montage=... Specifies the Montage name, e.g.
/Montage=xyz

If the Montage name contains spaces, then use quotation marks:
/Montage="x y z“

The related file must be located within the Workfiles folder (see
page 40). Only specify the file name WITHOUT its extension (*.MONT?2).




66 Chapter 3 Getting started and handling the program

Example

Verify Workspace

Figure 3-31. Editing the command line

) 2131AAB_HC Properties (=2

Security Details Previous Versions
General Shorteut Compatibility

@ 2131AAB_HC

Target type: Application

Target location: Recliew

| Target: C:hVision\RecView'\RecView exe /Workspace=C

Start in: ChVisionRecView

Shortcut key:  None \

Run: [Norrnal window '\

Comment:

[ Open File Location ][Change leon... ] [ Advanced... ] \

[ ok ][ cencel || ppy

C:Wision\RecView\RecView.exe fworkspace=C:Wision\Workfiles\2131AAB_HW rawksp /Server=localhost /Montage=xyz

If you click on the shortcut, RecView starts and immediately opens the linked workspace (in
the example: 2131AAB_HC.rvwksp). In the status-bar of RecView you can verify, if the correct
workspace has been loaded (Figure 3-32).

Figure 3-32. Verify correct workspace

| [2131A88_HC |<

Windows creates the RecView shortcut on the Desktop, but you can move it to any other di-
rectory on your PC, network or external data storage. If you move it to a network location or
external data storage, please make sure to open the shortcut from the PC on which the work-
space is actually located. ®
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N\

pter 4 Configuring the user settings

To open the dialog box for configuring user settings, choose Configuration » Preferences...
from the menu (see Figure 4-1). The dialog box is made up of six tabs whose functions are
described below. Most of the configuration options relate to the way in which the data is rep-
resented.

Figure 4-1. Calling the "Preferences" dialog box
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Filter Tree... Ctrl+Shift+F
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4.1 Configuring the scaling

The Scaling tab is used to configure the scaling parameters.

Figure 4-2. Configuring the scaling parameters

Scaling |ans I Graph Dis;:layl Frequency Bands | Blectrods F'ositionsl Fitter Tree Configuration I
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Default Scaling [uV]: I‘IDD
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Default Display Freguency Range [Hz'Zﬁﬂ

Set Individual Scaling Factors... |

You can make the following settings:

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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Individual scaling is desir-
able for ECG channels, for
example, since otherwise
they encroach badly on the
curves of the EEG channels.
The attenuation only af-
fects the display of the da-
ta; it does not affect the
data itself.

The Polarity: Positive Down function defines the polarity of the displayed signal. If you
select the check box, the axis for positive measured values points down.

If you select the Start with Display Baseline Correction On check box, the baseline cor-
rection function in the data view is activated by default.

Default Scaling [uV] specifies the default scaling used when data is first displayed. You
can enter the values for data from the time domain and the frequency domain inde-
pendently of each other.

Default Display Time [s] specifies the interval represented in the time domain in seconds.

Default Display Frequency Range [Hz] specifies the interval represented in the frequency
domain in hertz. The frequency domain always starts at 0 Hertz.

The Set Individual Scaling Factors function allows you to specify the channels that are to
be displayed attenuated. In the table, enter the channel names and the associated scal-
ing factors by which you want to reduce the scale of the signals (see Figure 4-3).

Figure 4-3. Scaling selected channels

Individual Scaling Factors . @

Channel Name Attenuation Remove Row

EKG1 5

: Remave All

Ok Cancel




4.2  Configuring the axes

The Axes tab allows you to configure the x- and y-axes.

Figure 4-4. Configuring the axis parameters

Preferences
raph Display] Frequency Bands ] Electrode Positions ] Fitter Tree Configuration ]
Domain Master Switch: IW‘
¥ Lz Y Bz
(™ Show Never (" Show Never
(¥ Show if Size is Sufficient % Show if Size is Sufficient
{” Show Always {” Show Always
W Show Unit Label [¥ Show Unit Label
Tickmark Settings Tickmark Settings
Tickmark Spacing: Automatic Tickmark Spacing: Automatic
Tickmark Length: Automatic Tickmark Length: Automatic
Labels Shown: Yes Labels Shown: Yes
Label Spacing: Automatic Label Spacing: Automatic
Label Tick Length: Automatic Label Tick Length: Automatic
Change... Change.
[ =

The Domain Master Switch drop-down list allows you to specify whether the settings refer to

the Time Domain or to the Frequency Domain.

You can make the following settings separately for the x- and y-axes:

» The Show Never | Show, if Size is Sufficient | Show Always options allow you to specify
whether the axis is not to be displayed, only to be displayed if there is enough space or

always displayed.

» Ifyou check the Show Unit Label box, the units (uV, s, Hz, etc.) of the axes are displayed.

» The Tickmark Settings group describes the intervals for the subdivisions of the axis. To
change the settings for the arrangement, interval and labeling, click Change.... The Axis
Tick Configuration dialog box opens (see Figure 4-5).

Configuring the axes 69
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Figure 4-5. Configuring the subdivisions of the axis (tickmarks)

Hoas Tick Configuration &J

Tickmarks

% Set Automatic

" Set Manual
Tickmark Spacing: ’Ii
¥ Auto Tickmark Length
Tickmark Length: ’47
Tickmark Labels
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Label Spacing: 1
[V Auto Label Tick Length

Label Tick Length: |4

oK | Cancel |

You can make the following settings in the Axis Tick Configuration dialog box:

>

You can either have the intervals calculated automatically (Set Automatic option) or set
them manually (Set Manual option).

Enter the axis subdivision interval in the Tickmark Spacing text box and the length of the
tickmark in the Tickmark Length text box.

If you check the Auto Tickmark Length box, the length of the tickmark is determined au-
tomatically.

The Show Labels check box is used to specify whether the subdivisions of the axis are
labeled and if so at what intervals (Label Spacing text box). This specification deter-
mines the number of tickmarks after which a label is displayed.

The Label Tick Length text box is used to specify the length of the labeled tickmarks. If
you check the Auto Label Tick Length box, this length is determined automatically.



4.3 Graph display

The Graph Display tab is used to configure how graphs are displayed.

Figure 4-6. Configuring how graphs are displayed

Preferences

Scaling ] Pes

Frequency Bands | Electrode Positions ] Fitter Tree Configuration ]

Time Domain

{* Draw Data as Graph

(" Draw Data as Block

Freguency Domain

{* Draw Data as Graph
(" Draw Data as Block

¥ Draw Fill Colors

You can make the following settings:

» The Draw Data as Graph and Draw Data as Block options allow you to specify whether
the individual data points are to be drawn as a graph or as discrete blocks. You can make
this setting separately for the time domain and the frequency domain.

» Forthe frequency domain only, the Draw Fill Colors option allows you to specify whether
the area under the graph is filled with colors. If you choose to do so, the frequency bands
set on the Bands tab are highlighted in color (see “% Section 4.4 as of page 72).

Graph display 71
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4.4 Representation of the frequency bands

The Frequency Bands tab allows you to define frequency bands and assign colors to them.
This is used when representing frequency data (e.g. FFT).

Figure 4-7. Defining frequency bands

Preferences

Scaling | fues | Graph Display ~Frequency Bands | Blectrode Positions I Fiter Tree Configuration |

Name Color Begin [Hz] End [Hz] Defaults |
ESub-Delta

_Remore Rou

Remave All |

You can make the following settings:

>

In the table, you can specify the color of a band, its name and where it starts and ends (in
which columns from left to right) in hertz. You change the color for the band by clicking
on a color swatch in the Color column. This opens the color selection dialog box.

To extend the table, click in an empty row andfillin a cell. Anew row is then automatically
added to the table.

The Remove Row and Remove All buttons allow you to delete the selected row or all rows
respectively.

The Defaults button allows you to reset all the values modified in the table to their initial
configuration.



4.5 Adjusting the electrode positions

RecView uses the 10/10 coordinate system for calculations which depend on the electrode
positions (such as the map). If the names or positions you use differ from this system, you
can specify them in the Electrode Positions tab.

Figure 4-8. Selecting the electrode positions
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You can make the following settings:

» Onceyou have established a connection between RecView and the Recorder by means of
Connect to Vision Recorder il, you can select the names of the electrodes that are cur-
rently being used from a drop-down list in the Name column. Alternatively, you can enter
the electrode names by hand.

» The Remove Row and Remove All buttons allow you to delete the selected row or all rows
respectively.

» The Reset Row button allows you to undo the changes made for the channel.

Adjusting the electrode positions 73

You will find a description
of the electrode coordinate
system in Appendix A as of
page 139.
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4.6 Configuring fast access to the parameters dialog

In the Filter Tree Configuration tab, you can choose between two ways of configuring fast ac-
cess to the filter parameter dialog: The dialog can be opened automatically whenever you
drag and drop afiltericon to the filter tree and/or whenever you double-click the correspond-
ing filter node in the tree.

Figure 4-9. Configuring fast access to the filter parameter dialog

Preferences

Scaling I Poes I Graph Displayl Frequency Bands I Blectrode Positions  Filter Tree Configuration

Configure Quick Access to Filter Parameters

[~ Open Parameter Dialog Automatically on Adding a Filter to the Filter Tree
¥ Open Parameter Dialog by Double Clicking a Filter Node




Chapter 5 Montages

Montages enable channels to be reconnected in the software, i.e. new voltage references are
assigned to the channels. Montages also serve to optimize the display of data, e.g. by com-
bining frontal electrodes in one montage and occipital electrodes in another one. When a
montage is selected, only those channels which have been assigned to it are displayed. The
sequence of channels can also be changed using montages so that channels which were
originally apart can be shown next to each other. A channel can also be displayed multiple
times in a montage.

A montage is used for visualization purposes only. The resulting data only exists temporarily
and is not passed to downstream filters.

The current version of RecView does not allow you to create montages. On the other hand,
you can use all the montages created in the Recorder and the montages from the Analyzer
with the exception of Laplacian Reference montages.

To show all the montages in the Work Files folder, click Display Montage in the RecView
menu bar. Select a montage to apply it to the main window.

Choosing Display Montage » Current Filter from the menu lists all the montages for the active
filter window if you have created a filter tree (see Figure 5-1). Always use the Current Filter
function if you want to apply a montage to the active filter.

Figure 5-1. Displaying and selecting montages (A)
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Alternatively, right-click in the data window and choose a new montage from the context
menu (see Figure 5-2).
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You should use the same
Work Files folder for
RecView as you do for the
Recorder to allow you ac-
cess to the Recorder mon-
tages.
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Figure 5-2. Displaying and selecting montages (B)
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You can assign keyboard shortcuts to montages to allow you to switch between them (see
Figure 5-3). Pressing these keyboard shortcuts activates the montages. To open the dialog
box for selecting the keyboard shortcuts, choose Display Montage » Options... from the

menu.

Figure 5-3. Assigning keyboard shortcuts to montages

Montage Options.

[

Key:

Ctrl-1
Ctrl-2
Cirl-3
Cirl-4
Ctrl-5
Ctrl-6
Ctrl-7
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Ctrl-0

Default Montage on Startup:
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Shortcuts for Montage Selection
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Bipolar1 -
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Averagel A

Average1
Bipolar2 k
Original 1

-

Press Shift together with the montage
hotkey to select the montage for the
active tree filter window.

OK Cancel

You can freely assign the keyboard shortcuts ¢Ctrl + 2> through <Ctrl + 0> to the existing mon-

tages. «Ctrl + 1> is reserved for the default montage. If you have created a filter tree, you can
use the shortcuts <Ctrl + Shift + 1> through <Ctrl + Shift + 0> to select the montage for the ac-
tive filter window. You also have the option of selecting a montage that will be used by de-

fault when data is first displayed in RecView (Default Montage on Startup).



Chapter 6 Basic filters

Note that any software filters such as Segmentation Filters that are active in the Recorder
have NO effect in RecView.

Figure 6-1. Software filters active in the Recorder have no effect in RecView
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Summary

Settings

6.1 Average

The Average filter is used to average previously segmented data or frequency data. The Aver-
age filter also allows you to precisely define the period over which averaging is to be per-
formed. You can define a given number of data blocks or a given window length over which
the filteris to perform averaging. You can also calculate a weighted average value across the
window, rectify the preceding signal and subtract the current average value from the current

block.

Because RecView is an Online application, the average can only ever be drawn for all the seg-
ments present at the given time. As a result, the first segment is shown without change. Fur-
ther segments have still not been passed to RecView by the Recorder at this time. As soon as
the second segment is available to RecView, an average is drawn across these two segments,

etc.

Figure 6-2. Parameters dialog box for the Average filter
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You can perform an optional baseline correction prior to averaging. To do this, check the En-
able Baseline Correction box.

You can now specify whether baseline correction is to be performed relative to the start of
the segment (Interval Relative to Start of Segment option) or relative to the marker (Interval
Relative to Marker option).

In both cases, the next group allows you to define whether the interval is to be determined
on the basis of time (Based on Time option) or on the basis of data points (Based on Data-
points option). If you choose to use time-based intervals, you enter the boundaries and du-
ration of the interval in the text boxes Start [ms], End [ms] and Duration [ms]. If you choose
to use data-point-based intervals, you enter the start and end points and the number of data
points in the text boxes Start Point, End Point and Points.

If you define an interval that does not lie within the segment boundaries, the program creates
the intersection between the interval you select and the segment that is actually present. If
the intersection is empty, no baseline correction is performed.

If youwish, you may rectify and prepare the signal blocks prior to averaging. To do this, select
the Enable Rectification check box. The data blocks can be rectified by forming the absolute
value (Absolute Values option) or by forming the squared absolute value (Squared Absolute
Values option). The squared value is used to measure the power density spectrum.

To calculate a weighted average of the data blocks, check the Enable Weighted Averaging
box. Enterthe number of preceding (i.e. past) data blocks that are to be included in averaging
in the Window Length text box. You can choose between three window functions:

» Equal.The Equal option generates a symmetrical rectangular window. All the data blocks
are weighted equally.

» Triangular. The Triangular option generates a symmetrical triangular window. As a re-
sult, at half the window length (Window Length box), the centrally located data block will
have the greatest weighting.

» Exponential. The Exponential option generates a non-symmetrical window which falls ex-
ponentially on one side. The value of the time constant is required for a complete defini-
tion of this window that falls exponentially on one side. It comprises the same number of
blocks as is specified in Time Constant.

Average 79
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By checking the Apply Zero-Phase Delay box, you are able to delay data output from the filter
by half the window length, i.e. the filter supplies the averaged data to the view with a lapse
of half a window length. Please note that in this case you must always select an even number
for the window length since this is the only way of defining an unambiguous midpoint in the

window.

If you want to depict current deviations from the long-term average value, check the Subtract
Weighted Average from Current Segment box. This subtracts the stored average from the

current segment.

Figure 6-3. Average filter
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6.2 Band Power Trigger

The Band Power Trigger filteris used to send signals to the computer's LPT port as a function
of their band power values. The use of this filter is particularly recommended within the
framework of neurofeedback research.

The filter can only be used with frequency data (FFT-filtered data).

You must possess administrator permissions in order to use LPT port control. Under Win-
dows® Vista and Windows® 7, you must also start RecView in Administrator mode even if
you are already logged in as administrator at the computer (see also “@ section 3.4 on
page 58).

Figure 6-4. Parameters dialog box for the Band Power Trigger filter
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You can enter the limit values for the required frequency band in the Minimal Frequency [Hz]
and Maximal Frequency [Hz] text boxes.
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If the option Calculate Raw
Sum of Squared Values is se-
lected then the threshold values
are specified in pVv2. In the case
of Calculate Power Density,
these values are specified in
pV2/Hz and in the case of Calcu-
late Relative Band Power, they
are specified in %.

There are three different ways of calculating the band power:

» Calculate Raw Sum of Squared Band Values. The squared values of all the frequency val-
ues within the previously defined frequency band are totaled. You should note that the
number of totaled frequency values depends on the resolution.

» Calculate Power Density. The power density is displayed.

» Calculate Relative Band Power. The system calculates the ratio of the power within the
defined frequency limit values to the power of the total spectrum of the signal.

For all three calculation options, you can enter an upper and lower threshold value in the
Lower Bandpower Threshold and Upper Bandpower Threshold text boxes. A trigger is then
sent to the LPT port if the value rises above or falls below these thresholds.

The channels selected in Used Channels are used for the calculation. The result is divided by
the number of channels used.

Inthe Trigger Configuration group, you specify what trigger types and trigger values are sent
to the LPT port: discrete TTL pulses or continuous TTL signals. The associated table contains
the events Upper Threshold Exceeded and Lower Threshold Under-Run. Upper Threshold
Exceeded indicates that the value specified in Upper Bandpower Threshold has been ex-
ceeded. Lower Threshold Under-Run indicates that the value has dropped below that spec-
ified inLower Bandpower Threshold.

If you select the Discrete TTL-Pulses option then triggers are sent as TTL pulses to the LPT
port. The status of the LPT port is reset to O after the period defined in TTL-Pulse Length. In
this mode, both rows can be accessed in the table and TTL pulses can be configured for both
events. You can check the associated boxes in the Set TTL column in the table to specify
whether you actually want the event to release a trigger. The trigger value can be configured
in the form of an 8-bit hexadecimal value (0 to FF) which you enterin the cell TTL Value [hex].

In the TTL-Pulse Length [ms] text box, you specify the time after which the TTL pulse is reset
to 0. If you enter the value 0 in the text box then it is reset immediately. Pulses that are reset
immediately or very quickly (¢ 20 ms) cannot be displayed in the LPT status output. You
should also note that the accuracy of the reset timer depends on the resolution of the Win-
dows® internal system clock. It is therefore not possible to guarantee that timing will be ac-
curate to the nearest millisecond.

You should also note that TTL pulses are subject to temporal overlaps. This occurs if two (or
more) events are detected within the period defined in TTL-Pulse Length [ms]. By default, in
such cases the filter causes the trigger activated by the first event to be overwritten by any
subsequent trigger. If you want to prevent triggers from being prematurely overwritten, check
the Inhibit additional TTL-Pulses for box and specify the required inhibition period in the In-
hibition Period [ms] text box. Events that are detected during the inhibition period do not
trigger any additional TTL pulses.
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If you enteridentical values in the Inhibition Period [ms] and TTL-Pulse Length [ms] text box- <@ For a diagrammatic over-
es this prevents triggers from ever being overwritten. By choosing an inhibition period that view of the behaviqr of TTL
is longer than the value specified in TTL-Pulse Length [ms], you can prevent TTL pulses from pulses, see Appendix D as of

page 147.
occurring more frequently than you would want.

If you select the Hysteresis option then continuous TTL signals are sent as triggers to the LPT
port. In the table, you can now only access the Upper Threshold Exceeded row, i.e. it is only
possible to configure a TTL signal for the Upper Threshold Exceeded event. When the signal
is sentto the LPT port, the LPT port status is retained until it is reset to the value O in response
to the occurrence of the Reset event.

Figure 6-5. Band power trigger filter
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In many cases it can be difficult to select appropriate threshold values at the start of an ex-  Online configuration of the
periment. In addition, the behavior of the EEG data spectrum often changes over long peri- ~ Band Power Trigger filter
ods of time (for example, if the test subject becomes tired during a comparatively long
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experiment). For this reason, there are two slide controls which enable you to adjust the
threshold values subsequently. The left-hand control adjusts the lower threshold value and
the right-hand control the upper threshold value. After selecting a control, you can also ad-
just it at the keyboard using the <Up Arrow» and <Down Arrow» keys.

You can also use the Scale Up ﬂ and Scale Down ﬂ buttons to adjust the scaling in the
normal way. When you perform scaling, it is possible that the two threshold values may no
longer be visible in the display window because they are greater than the currently displayed
maximum value. In this case, first drag the left-hand control (for the lower threshold value)
and then the right-hand control back into the window. You can use the Reset to Initial Con-
figuration... button to restore the parameter dialog settings to their initial values if you have
changed them.

You should note that none of the adjustments you make in Online operation are persistent,
i.e. the modified values are not saved as filter parameters.

If you want to identify the changes you have made during Online operation in your data, use
the Recorder to set related "Comment" markers shortly after making each change. See the

* Recorder User Manual for detailed information on how to add comments to your record-
ing data in the form of markers.



6.3 Bipolar Montage

Montages enable channels to be reconnected on a software basis. The Bipolar Montage filter
allows you to assign a channel a second channel as a new voltage reference. In this way, you
define new channels that are derived from the difference in voltage between the two original
channels.

Unlike the montages described in Chapter 5, the Bipolar Montage filter is not used solely for
visualization purposes, in other words, the data generated by the filter affects downstream
filters.

You have the choice of either forming the difference from two consecutive channels in the
channellist (Each Channel Uses the Following Channel as Reference option) or freely select-
ing the two reference channels using the table (Define Reference Channels option).

The Clear all button allows you to delete all specifications from the table.
If you check the Display Old Channels box, the original channels are displayed alongside the

newly defined channels.

Figure 6-6. Parameters dialog box for the Bipolar Montage filter
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Figure 6-7. Bipolar Montage filter
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6.4 Bridge Tool

You can use the Bridge Tool filter to detect any gel bridges that may potentially exist between
neighboring channels. Gel bridges occur when the conductive gel that is used to reduce the
skin's electrical resistance spreads across the skin of the test subject's head. This creates
connections — or bridges — between neighboring electrodes and the corresponding channels
are, for practical purposes, short-circuited. The signals in the affected channels have an ab-
normally high level of similarity. The Bridge Tool filter recognizes this abnormally high simi-
larity between neighboring channels and displays this in graphical form.

Using the Bridge Tool filter reduces the probability that you will create gel bridges when pre-
paring the electrodes. In addition, the filter can help you achieve a long-term reduction in the
time required for preparation by allowing you and your personnel to gain experience of the
required amounts of gel. Once the potential presence of gel bridges has been detected, you
must decide whether or not to continue with the measurement.

While you are performing impedance measurement using the actiCAP ControlSoftware or the
Recorder, you can also run RecView in parallel. However, if you wish to reliably detect gel
bridges, the actiCAP ControlSoftware and the Recorder must not be in impedance mode.

Figure 6-8. Filter tree with Bridge Tool filter and associated parameters dialog box
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In the Bridge Tool filter's parameters dialog box, you can set the sensitivity to be used for the
detection of gel bridges between two channels. If in doubt, you should choose Low. Of
course, setting the sensitivity to High increases the probability that gel bridges that are gen-
uinely present will be detected. At the same time, however, this also increases the probabil-
ity of false alarms, i.e. gel bridges may be reported even though none actually exist. The
opposite applies to the setting Low.

To obtain values that will help you decide on the optimum detection sensitivity more quickly,
we recommend that you create a filter tree consisting of three Bridge Tool filters arranged in

Summary
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parallel and assign each filter one of the three settings: High, Medium, Low. A bridge alarm
should then only be interpreted as indicating a genuine bridge if it appears permanently
when Low is set.

Start RecView. The right-hand window (filter window) contains a Paired Channel View cover-
ing all the electrode positions. If gel bridges are present, the view indicates red connecting
lines between the relevant electrode positions after about a minute (see Figure 6-9).

You should note that due to the fact that the view is continuously updated, the red connec-
tion lines may disappear again.

To reliably identify bridges and avoid creating any artifacts, do not apply any more gel. You
should also make sure that the test subject keeps his/her eyes open, moves as little as pos-
sible and does not speak. If a connecting line is continuously displayed for several minutes
then this very probably indicates a genuine gel bridge. If a line is only illuminated sporadi-
cally and then disappears again, then this is a false alarm and it is very probable that no gel
bridge actually exists.

It is possible that the Bridge Tool filter may incorrectly interpret artifacts in the EEG as gel
bridges. This is particularly likely if an electrode has just been filled with gel or if the test sub-
ject moves or talks. If the filter identifies more gel bridges than a fixed upper limit that is de-
pendent on the number of channels used, then the Bridge Tool filter switches to Automatic
Mute Mode. In this mode, the Paired Channel View statically displays all the potential gel
bridges as dark red lines. If these lines are simply artifacts, the Bridge Tool filter switches
back to normal mode as soon as the EEG is free of artifacts again and the indicated bridges
have disappeared again.

If gel bridges are actually present and the static red lines persist, we recommend that you in-
terrupt the measurement and prepare the electrodes again using a considerably smaller
quantity of gel. As a guideline gel quantity, we recommend using approximately 10 cm? of
gel for 30 channels.



Figure 6-9. Displaying gel bridges in the Paired Channel View
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Sensitivity: HIGH

Before performing any measurements with test subjects for research purposes, you should
conduct a number of test data acquisitions in order to gain experience of the conditions of
use of the Bridge Tool filter, for example concerning the test subject’s hair length and head
shape, the amount of gel to be applied and the position of the electrode cap.

If you still have little experience of preparing electrodes, we recommend that you should pro-
ceed as follows when using the Bridge Tool filter. This procedure is also useful if you want to
use the Bridge Tool filter to train your personnel in cap preparation.

1 Fill 6to 10 neighboring electrodes with gel and optimize the impedances (electrode LEDs
glow green). When doing this, use as little gel as possible.

2 Use the Bridge Tool filter to perform regular checks of this group of neighboring elec-
trodes for the presence of bridges during the preparation procedure. To do this, switch
the Recorder software between impedance 1 |and @‘monitoring mode.

3 Ifyoudetect a large number of gel bridges during the preparation stage, you must decide
whether to interrupt or continue the measurement.

Bridge Tool

Tips on the use of the Bridge
Tool filter
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Requirements relating to the
test subject

Practical experience concern-
ing the number of electrodes

Related publications

4 When you have finished preparing all the electrodes, apply the Bridge Tool filter again in
order to obtain definitive information about the possibility of gel bridge formation.

If you already have a lot of experience of preparing electrode caps, we recommend that you
proceed as follows when using the Bridge Tool filter in order to minimize the time spent pre-
paring the electrodes:

1 Useas little gel as possible and attempt to obtain good average values for the impedanc-
es of all electrodes (electrode LEDs glow yellow).

2 When all the LEDs are glowing yellow or better, apply the Bridge Tool filter. The probabil-
ity of gel bridges occurring now is extremely low.

3 Nextfill the electrodes that are still glowing yellow with another very small quantity of gel
until you reach the optimum impedance values (electrode LEDs glow green).

4  Apply the Bridge Tool filter again in order to obtain definitive information about the pos-
sibility of gel bridge formation.

Make sure that the test subject does not talk, move or close his/her eyes while the data is
being checked using the Bridge Tool filter.

In our experience, it is possible to prepare a cap with 64 or 128 electrodes without a single
gel bridge occurring — even with long-haired test subjects. In the case of caps using 256 elec-
trodes, it is possible to apply the gel without forming bridges provided that you perform the
preparations carefully.

Tenke CE, Kayser J, A convenient method for detecting electrolyte bridges in multichannel
electroencephalogram and event-related potential recordings, Clin Neurophysiol. 2001 Mar,
112(3):545-50.

Tenke CE, Kayser J, A convenient off-line method for detecting electrolyte bridges in multi-
channel ERP recordings, Psychophysiol. 2000, 37:94.

Greischar LL, Burghya CA, et al., Effects of electrode density and electrolyte spreading in
dense array electroencephalographic recording, Clin Neurophysiol. 2004 Mar, 115(3):710-
20.



6.5 FFT (Fast Fourier Transform)

The FFT filter transforms data from the time domain into the frequency domain. The resulting

data indicates the extent to which the individual frequencies are present in the EEG between
0 Hz and at most half the sampling rate.

Figure 6-10. Parameters dialog box for the FFT filter
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FFT Block Size allows you to specify the block size used for calculation, expressed as a num-
ber of data points. You can only select powers of 2. The larger the block size, the less often
the representation will be updated. But we recommend that you do not select too few data
points, as this may overload the computer and possibly cause data blocks to be lost.

Because the block size must always be a power of 2, the required block size is always zero-
padded to the next power of 2 with segmented data. This means that a data block that does
not already have a length corresponding to a power of 2 is padded with zeros.

If you check the Overlap Blocks box, the blocks are not processed sequentially, but are in-
stead overlapped. The percentage by which the blocks are to be overlapped is specified in
the Overlap in Percent (Max. 90%) text box. This value is restricted to 90%. If, for example,
you select an overlap of 75%, only 25% of the data points are new as of the first data block.
The advantage of overlapped processing of the data blocks lies in improved continuity in
data representation (see Figure 6-13).

Note that the overlap function is not available for segmented data.

If you select the Display as Frequency Graph option, the FFT data is displayed as frequency
graphs for each channel. The Show Frequency Band Names check box allows you to switch
the graph labeling on and off.

FFT (Fast Fourier Transform)

Summary

Settings

Defining the block size

<

Display options
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FFT data window

In the same way as the Peri-
odic option for the FFT in
the Analyzer, RecView con-
figures the right-hand mar-
gin of the window in such a
way as to optimize the ana-
lytical characteristics of the
window for its periodic con-
tinuation.

If you check the Display as Channel Map of Energy Density box, a map of the energy density
distribution is displayed for each frequency band. You can also set the scaling for the map in
Scale Maximum [uV?/Hz].

Since the FFT assumes that the segment will be periodically continued, artifacts occurin high
frequency ranges due to jumps to the segment boundaries. We advise using a window func-
tion to eliminate these artifacts. In the Data Window group, you can specify the type of the
FFT data window. The following three options allow you to choose between different window
types: No Window, Hanning Window and Hamming Window. In the Window Length [%] text
box, you enter the window length as a percentage of the segment length. The window func-
tion is displayed graphically in the filter's parameters dialog box.

If you selectthe Apply Variance Correction check box, the powerin the EEG signal is identical

before and after the application of the FFT, even when a window function is used.

In both representations (frequency graph or map), double-clicking enlarges it to occupy the
entire filter window (see Figure 6-11). If you double-click in the filter window again, you
switch back from individual-channel mode to the original view.

Figure 6-11. FFT in the frequency graph view using individual-channel mode
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Figure 6-12. FFT in the map view
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Figure 6-13. FFT filter without overlap (left) and with overlap (right)
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Summary

Settings

6.6 Frequency Filter

The Frequency Filter is used to restrict the bandwidth to a particular frequency range. It also
allows you to select a 50 or 60 Hz notch filter.

Check the appropriate box — Low Cutoff Filter, High Cutoff Filter, Notch Filter — to specify
what filter is to be used (high-cutoff, low-cutoff, notch).

In the case of the Low Cutoff Filter, enter the lower frequency threshold in Cutoff Frequency
[Hz]. The Slope [dB/oct] drop-down list allows you to determine the slope of the filter.

As with the Low Cutoff Filter, in the case of the High Cutoff filter, enter the upper frequency
threshold in Cutoff Frequency [Hz] and the filter slope in Slope [dB/oct].

In the case of the Notch Filter, you can select a Frequency [Hz] of 50 or 60 Hz. The slope of
this filter is fixed at 48 dB/octave and cannot be selected explicitly.

Figure 6-14. Parameters dialog box for the Frequency filter
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Figure 6-15. Frequency filter
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Summary

Prerequisites for use

Settings

6.7 Level Trigger

The Level Trigger filter allows you to set markers or send configurable signals to the comput-
er's LPT port as a function of the voltage curve fora selected EEG channel. The use of this filter
is particularly recommended within the framework of neurofeedback research.

The filter can only be used with time data.

You must possess administrator permissions in order to use LPT port control. Under Win-
dows® Vista and Windows® 7, you must also start RecView in Administrator mode even if
you are already logged in as administrator at the computer (see also @ section 3.4 on

page 58).

Figure 6-16. Parameters dialog box for the Level Trigger filter
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You define the threshold value in the Level Settings group. You specify a name for the thresh-
old that you want to search for in the Name column. In the drop-down list in the Channel col-
umn, you choose the channel on which the threshold is to be searched for. You specify the
threshold in pV in the Threshold column.

In the drop-down list in the Direction column, you specify the direction of the voltage curve
in which the threshold violation is defined. "Positive" means that the corresponding trigger
or marker is set when the voltage is rising and the threshold is reached. "Negative" means
that the corresponding trigger or marker is set when the voltage is falling and the threshold
is reached.



Depending on the direction set in Direction, the event Peak (see also second row of the table
inthe Trigger Configuration group) indicates the occurrence of a local maximum or minimum
value.

In the Reset Value column, enter the value in pV at which the event Reset Value Under-Run
is provoked (see description on this page). This value is usually identical with the Threshold
but you can set another value for certain purposes. If the direction is positive, the value ob-
tained must be below this one before a new Threshold Value Exceeded event can be pro-
voked; if the direction is negative, the value obtained must be above this one.

In the Time Tolerance [ms] text box, you can enter an interval during which the EEG curve
must rise or fall uniformly after reaching a local minimum or maximum in order to make it
possible for the minimum or maximum to be recognized as such. A marker is set for the min-
imum or maximum within this interval. You should adjust the size of the interval to the steep-
ness of the edges of the trigger channels.

You should note that RecView requires at least the time specified in Time Tolerance [ms] in
order to reliably detect a peak after its actual occurrence.

Inthe Trigger Configuration group, you specify what trigger types and trigger values are sent
to the LPT port: discrete TTL pulses or continuous TTL signals. The associated table contains
the events Threshold Value Exceeded, Peak and Reset Value Under-Run. Depending on the
direction specified in Direction, Threshold Value Exceeded indicates that the value set in
Level Settings has been exceeded exceeded or under-run. Reset Value Under-Run indicates
that the value has fallen below the specified value. Peak Found indicates the first local min-
imum or maximum that occurs during the period between the threshold being exceeded and
the reset.

Please note that RecView sends a single trigger or sets a single marker during the period be-
tween Threshold Value Exceeded and Reset Value Under-Run. It does this at the first detect-
ed local minimum or maximum. All further local minimums and maximums during the
interval between Threshold Value Exceeded and Reset Value Under-Run are ignored.

If you select the Discrete TTL-Pulses option then triggers are sent as TTL pulses to the LPT
port. All three rows are accessible in the table and TTL pulses can be configured for all three
events. You can check the associated boxes in the Set TTL column in the table to specify that
atriggeris actually to be sent to the LPT port. The trigger value can be configured in the form
of an 8-bit hexadecimal value (0 to FF) which you enter in the cell T7L Value [hex].

The TTL pulse is reset after the time specified in the text box TTL-Pulse Length [ms]; if the text
box has the value 0 then the pulse is reset immediately.

Pulses that are reset immediately or very quickly (< 20 ms) cannot be displayed in the LPT sta-
tus output. You should also note that the accuracy of the reset timer depends on the resolu-
tion of the Windows® internal system clock. It is therefore not possible to guarantee that
timing will be accurate to the nearest millisecond.

Level Trigger 97
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For a diagrammatic over-
view of the behavior of TTL
pulses, see Appendix D as of
page 147.

You should also note that TTL pulses are subject to temporal overlaps. This occurs if two (or
more) events are detected within the period defined in TTL-Pulse Length [ms]. By default, in
such cases the filter causes the trigger activated by the first event to be overwritten by any
subsequent trigger. If you want to prevent triggers from being prematurely overwritten, check
the Inhibit additional TTL-Pulses for box and specify the required inhibition period in the In-
hibition Period [ms] text box. Events that are detected during the inhibition period do not
trigger any additional TTL pulses.

If you enteridentical values in the Inhibition Period [ms] and TTL-Pulse Length [ms] text box-
es this prevents triggers from ever being overwritten. By choosing an inhibition period that
is longer than the value specified in TTL-Pulse Length [ms] then you can prevent TTL pulses
from occurring more frequently than you would want.

If you select the Hysteresis option then continuous TTL signals are sent as triggers to the LPT
port. In the table, you can now only fully access the Threshold Value Exceeded row, i.e. it is
only possible to configure a TTL signal for the Threshold event. When the signal is sent to the
LPT port, the LPT port status is retained until it is reset to the value 0 in response to the oc-
currence of the Reset event.

You can also set a marker for each of Threshold Value Exceeded, Peak Found and Reset Val-
ue Under-Run by checking the corresponding box in the Set Marker column. Please note that
the Peak marker is set at the time when the peak is recognized as such. In the data, it there-
fore appears offset from the real peak by the value specified in Time Tolerance.
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Figure 6-17. Level Trigger filter
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Summary

Linear Derivation filter in
RecView compared to the
Linear Derivation trans-
form in the Analyzer

6.8 Linear Derivation

The Linear Derivation filter allows you to generate new channels through linear combinations
of existing channels. The new channels are calculated from coefficients that are assigned to
existing channels based on the following formula: New channel = coeffl * channell + coeff2
* channel2 + ....

Unlike the operation of the Analyzer's Linear Derivation transform, RecView does not know
the input channels that are present in the data set at the time of parameter entry. If you do
not read the coefficient matrix from a file, you must therefore enter the channel names man-
ually.

Here, you should note that you do not need to enterall the input channels but only those that
you require for the generation of the new channels that you wish to create. For example, if, in
a data set, you want to generate a new channel as the sum of the input channels 0.3*Fp1 and
0.33*Fp2 then the specifications entered in Figure 6-18 are sufficient, even if the input data
contains further channels.

Figure 6-18. Generating the new channel from the combination of the input channels Fp1
and Fp2
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Figure 6-19. Parameters dialog box for the Linear Derivation filter

Linear Derivation

If you select the Keep Old Channels check box, the old channels are included in the new data
set; that makes the new channels additional channels. If you do not check the box, the new

data set consists only of the new channels.

¥ Keep Old Channels MNumber of Mew Channels: m Saveto
[~ New Channels on Top Number of (Used) Input Channels m Load from
i Used Input Channels

>__ Fp1 Fp2 AF3 AF1 AFz AF2
] FOD 0.01886879 |D.01550607 |0.05276779 |-0.005698975 |0.01113171 0.0010865
FO1 0.01216254 | D.02667836 |0.02508937 |0.0003135398 |-0.01188219 |-D.0165563
N FO2 0.01004132 | D.02798324 |0.002041995 |-0.0009478853 |0.01980104 | 0.0068015
:. FO3 0.005132434 |D.001959419 |0.007568133 |0.0158857 0.005495728 | 0.0D069618I
c FO4 0.0002894236 | 0.005805029 |0.001035406 |-0.01009123 |0.008764028 |-0.0020468
: FO5 -0.005706147 |-0.03689781 |-0.008421344 |0.02429723 | 0.002569839 |0.0045098!
n FO& 0.05768489 |0.01407431 |0.03182536 |0.0914616%  |-0.009975952 |0.0030411
: FO7 -0.009691566 |-0.005631357 |0.009835472 |0.0364661 0.01223502  |-0.0007360
L Fog 0.0183203 001267678 |0.008130919 |0.0D03843155 |0.0004004566 |-0.0013863
FO9 0.01496931 |-0.01919437 |-0.02875056 |0.0248083 0.02428289 | 0.0198049!
F10 0.04581244  |-0.005888857 | 0.0203287 0.0022572%6 |-0.03781291  |-0.0246052
Ei1 nn97RNa73 |4 9R1ARTENT (ANAM319191 InntansIes Inno7eTRas | onnneedsd

If you select the New Channels on Top check box, the new channels are listed first.

In the Number of New Channels text box, you specify the number of new channels you re-
quire. You enter the number of input channels in the Number of (Used) Input Channels text

box. You can use the Refresh button to update the coefficient matrix.

As an alternative to the manual entry of the input channels, you can also read in a coefficient
matrix from a text file by clicking the Load from File... button. If you choose this method then
you do not need to edit the channel matrix in RecView. The matrix must have the following

structure:

Table 6-1. Structure of the channel matrix that is to be read in

Channell Channel?2 Channel3
New1 Coefficient? Coefficient Coefficient
New?2 Coefficient Coefficient Coefficient

a. The decimal separator used in the coefficients is the decimal point (.)

Linear Derivation 101
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You can also read in ICA matrices that have been exported from the Analyzer or coefficient
matrices that have been generated and stored using the Analyzer's Linear Derivation trans-
form. Reading in exported ICA matrices permits the Online output of ICA components that
have been calculated offline using the Analyzer.

To save the matrix, click Save to File.... The Remove Line and Remove Column buttons allow
you to delete the selected rows or columns from the matrix.

Figure 6-20. Generating new channels using the Linear Derivation filter
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LORETA

6.9 LORETA

The LORETA filter allows you to view the EEG data as LORETA data over the time domain. Re-  Summary
gions of interest (ROIs) are defined for this purpose. Each ROl is displayed in RecView as a
virtual channel.

The virtual MR anatomical images are made available by the Montreal Neurological Insti-
tute of McGill University.

Figure 6-21. Parameters dialog box for the LORETA filter Settings

Loreta Transformation - Definition of Regions of Interest ool

New ROI . .
Anatomy:
[averagea0s -

Details of Selected Region of Interest:

6
4
0
i ‘ | Value Extracted from Vaxels
& " X Coordinate
‘ | ¥ Coordinate
é " Z Coordinate
" Absolute Value
é " Power
Import ROls.. ™ Keep Old Channels
Export ROls a

In the LORETA filter dialog box, click New ROL... to create a new ROI (see Figure 6-22). The New  Defining the ROIs
Region dialog box appears, in which you can enter the name of the new ROI. The name you
enter here is also the name of the virtual channel.

Figure 6-22. Creating an ROI
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To add lobes to the ROI, click Add Lobe.... The Left, Both and Right options allow you to
choose whether the left, right or both lobes are to be added (see Figure 6-23).

Figure 6-23. Adding lobes
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In the same way as selecting lobes, you can use the Add Gyrus... and Add Brodmann Area...
buttons to add gyri and Brodmann areas to the ROI.

The ROIs are defined (block, The Add Current Position... button allows you to add a specific position to the ROI (see
PPi“t’ circle) using the MNI coor- Figure 6-24). You can choose whether to add the nearest voxel to the mouse pointer (by se-
dinate system. lecting the Nearest Voxel option) or to define a sphere with a specified radius around the cur-

rent position (by selecting the Sphere around Point option).



Figure 6-24. Adding a specific position
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The Add Block... button allows you to add a rectangular block, whose limits you can specify
(see Figure 6-25).

Figure 6-25. Adding a block
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The Details of Selected Region of Interest box lists all the specifications shown above (see
Figure 6-26)
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Other settings

Navigation

Figure 6-26. Part of the LORETA filter dialog box, containing a list of the components of the
ROl "Frontal"
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The Anatomy drop-down list allows you to choose between various virtual MR anatomical im-
ages.

The Remove ROl and Remove All buttons allow you to remove ROIs individually or all at once.

In the Value Extracted from Voxels group, you can specify which value is to be calculated for
the virtual channel from the corresponding ROI. You can choose the x-coordinate, y-coordi-
nate, z-coordinate, absolute value of the coordinates or power (square of the value).

The Keep Old Channels check box allows you to specify whether the original channels are to
be retained. The New Channels on Top check box allows you to specify whether the virtual
channels are to be displayed before the original channels in the filter window.

The Up and Down buttons allow you to specify the order of the ROIs in the data set.

The Import ROIs... button allows you to read in ROIs that have already been created. The Ex-
port ROIs... button allows you to export ROIs you have created as an XML file so that they can
be used subsequently.

The Export Blank ROIs File button exports voxel data, including the anatomical data, in a CSV
file. You can open this file in Excel, for example, define the ROls manually and reimport them
as a CSVfile.

If you edit this CSV file, it is essential to make sure that you do not change the number or se-
quence of the rows in the table. Otherwise errors may occur when you import the file again.

The values in CSV files are separated by commas and not, as in earlier versions of the trans-
form, by semicolons. Please note this when exchanging data with other programs and when
reading older CSV files.

You can navigate in the cross-sections or layers of the tomography either by using the mouse
to move the four yellow sliders on the borders of the cross-sections in the desired direction
or by clicking a point in the cross-section and using the mouse wheel to scroll up and down.
When you click in a cross-section, the position of the sliders is updated.



An information field is displayed below the 3D anatomies. This refers to the position of the
mouse and contains the following information in the following sequence (see Figure 6-27):

» The parentheses contain the cross-section coordinates of the current position of the
mouse pointer (crosshair). When you move the mouse pointer around the cross-section,
the coordinates displayed change accordingly.

» The value for Best Match at specifies the distance from the current mouse position of the
next voxel containing stored physiological data.

» The next three lines indicate the associated anatomical data of the brain areas in the vi-
cinity of the mouse pointer.

Figure 6-27. Display of the mouse pointerin the cross-section and the information field

L S 0 Add Lobe ...
Add Gyrus ...
Add Brodmann Area

Add Current Position

Add Block ...
Sgh e o] Import ROls...
Best Match at 2mm (e e )
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Medial Frontal Gyrus

Export Blank ROls Fi

When the LORETA filter is used, each ROl is represented as a virtual channel (see Figure 6-
28).

LORETA
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Scaling the virtual ROI chan-
nels

Figure 6-28. Virtual channels "Frontal" and "Frontal_2"
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Because very flat data is displayed if the unit pA2/mm? is used, we recommend that you
scale the data upwards considerably in the LORETA filter window. In the Preferences menu,
specify individual scaling for your virtual ROI channels to avoid having to re-scale the data
subsequently each time a new connection is established between the Recorder and RecView.
When you do this, assign unique names that are not used in the original data set to the ROI
channels.

To open the dialog box for configuring preferences, choose Configuration » Preferences...
from the menu. On the Scaling tab, click Set Individual Scaling Factors... (see Figure 6-29).



Figure 6-29. Performing individual scaling of the the ROl channels (A)
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In the Individual Scaling Factors dialog box, specify the required channel name in Channel
Name and the attenuation factor for this virtual channel in Attenuation. As shown in the ex-
ample (see Figure 6-30), we recommend that you choose a factor of 0.00001.

Figure 6-30. Performing individual scaling of the ROI channels (B)
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Summary

Continuous time data

6.10 Map

The Mabp filter shows the interpolated voltage distribution over the surface of the head. This
is done using the electrode positions and the voltages at the individual electrodes. You can
apply the Map filter to continuous and segmented time data and to frequency data.

Ifyou apply the Map filterto continuous data, a Map is displayed over a defined time interval.

Enter the interval for which the data points of each channel are averaged before they are
used for calculating the Map in the Display Interval [ms] text box.

Enter the lower and upper limits of the scale in the Scale Minimum [uV] and Scale Maximum
[uV] text boxes.

The Number of Equal Sized Subsegments to Map text box is not enabled if you apply the Map
filter to continuous time data.

Figure 6-31. Configuring the Map filter for continuous time data
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If you check the Extrapolate Edges for Full Map box, all the electrodes present in the visible
portion of the sphere are shown. The data required for this representation is extrapolated.

If you check the Show Electrode Positions in Map box, the electrodes appear as small dots
on the Map.



If you are using your own naming conventions for electrodes, you can enter the electrode po-
sitions by choosing Configuration » Preferences ... from the menu and choosing the Elec-
trode Positions tab (see also “@ Section 4.5 on page 73).

Figure 6-32. Map filter for continuous time data
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If you apply the Map filter to segmented data, you are able to show the average voltage dis-
tribution of the entire segment or of several partial segments of equal size.

Th

e settings for segmented time data are the same as those for continuous time data with

the following exceptions:

>
>

Th

The Display Interval [ms] text box is not available.

In the Number of Equal Sized Subsegments to Map text box, you specify the number of
partial segments to be displayed per segment. When the partial segments are represent-
ed as a Map, the data points for each channel that belong to each partial segment are av-
eraged before they are used for interpolation.

e Scale Minimum [uV], Scale Maximum [uV], Extrapolate Edges for Full Map and Show

Electrode Positions in Map functions are still available (see also the description under <@
Continuous time data on page 110 in this section).

g

Segmented time data
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Figure 6-33. Configuring the Map filter for segmented time data
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If you apply the Map filter to frequency data, a Map is shown for each frequency band. To
change the assignment of colors to the frequency bands, choose Configuration > Preferenc-
es... from the menu. In the Preferences dialog box, select the Frequency Bands tab and make
the adjustments you require (see also “@ Section 4.4 on page 72).

In the case of frequency data, you can only set the upper limit of the scale (in the Scale Min-
imum [uV?/Hz] text box). In addition, the Extrapolate Edges for Full Map and Show Electrode
Positions in Map functions are available (see also the description under @ Continuous
time data on page 110 of this section).

Figure 6-35. Configuring the Map filter for frequency data
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Figure 6-36.

Map filter for frequency data
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6.11 R-Peak Trigger

The R-Peak Trigger filter is used to detect R-peaks in data sets that are not recorded in the MR
scanner.

The filter can only be applied to continuous time data which provide a good ECG signal (R-
peaks).

The filter cannot be applied to data which is recorded in the MR scanner because the character-
istic curve of the ECG signal is much less well-defined in MR data.

You must possess administrator permissions in order to use LPT port control. Under Win-
dows® Vista and Windows® 7, you must also start RecView in Administrator mode even if
you are already logged in as administrator at the computer (see also “% section 3.4 on
page 58).

Figure 6-37. Parameters dialog box for the R-Peak Trigger filter

Parameters for R-Peak Trigger ’ &J

Trigger Configuration

TTL-Pulse Value [hex]: FF
TTL-Pulse Length [ms]: 30

Detection Parameters
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I | Ec-channe: ekG1 | ||

ok | Cancel |

The R-Peak Trigger filter detects R-peaks in the EEG. If detection is successful, a markeris set
and a trigger is sent in the form of a TTL pulse to the LPT port. The trigger value can be config-
ured in the form of an 8-bit hexadecimal value (0 to FF) which you enterin the cell TTL-Pulse
Value [hex]. The TTL pulse is reset after the time specified in the text box TTL-Pulse Length
[ms]; if the box has the value 0 then the pulse is reset immediately.

Pulses that are reset immediately or very quickly (<« 20 ms) cannot be displayed in the LPT sta-
tus output. You should also note that the accuracy of the reset timer depends on the resolu-

R-Peak Trigger

Summary

Prerequisites for use

Settings
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tion of the Windows® internal system clock. It is therefore not possible to guarantee that
timing will be accurate to the nearest millisecond.

You specify the threshold that is to be used in Detection Parameters:

» If you have set a threshold manually, activate the Use following Threshold option and,
in the Threshold [uV] text box, enter a voltage whose violation is to trigger the search for
an R-peak.

To specify a value manually, you should record the ECG signal and search for suitable val-
ues (see Figure 6-38 on page 117 and the accompanying explanation). This manual defi-
nition is only suitable for data sets with a very regular ECG signal.

» To perform an automatic search for a suitable threshold value, activate the Estimate
Threshold Automatically option. The filter uses a variance criterion to decide where to set
the threshold. In the text box Time for Threshold Estimation [s], enter the period in sec-
onds during which the filter is to search for a suitable threshold. A sensible value is 10.
You should not use any value greater than 15.

When the period specified in Time for Threshold Estimation [s] has elapsed, the threshold
value is updated at periodic intervals. This results in a continuous and more stable detection
of R-peaks.

You enter the polarity of the R-peaks in the Peak Polarity text box. To determine the polarity,
view the data briefly in RecView or in the Recorder.

In the Time Tolerance [ms] text box, you can enter an interval during which the ECG curve
must rise or fall uniformly after reaching a local minimum or maximum in order to make it
possible for the minimum or maximum to be recognized as such. Please note that the R-peak
marker is set at the time when an R-peak is recognized as such. In the data, it therefore ap-
pears offset from the real R-peak by the value specified in Time Tolerance. The ideal length
of the Time Tolerance interval depends on the characteristics of the R-peaks. In Figure 6-38,
the R-peak in the ECG curve rises very steeply. After reaching the local minimum, the curve
falls steeply again. As a result, a comparatively short time interval should be chosen in this
case.

On the basis of the ECG curve characteristics, you should also choose the polarity and — if
you are not using automatic detection — a suitable Threshold value. In our example (see
Figure 6-38), we select "Negative" for Peak Polarity since the upward R-peaks are better de-
fined than the downward ones. For the Threshold, we also choose a voltage value which ap-
proximates to the straight line drawn in on the graph (this only affects the option Use
following Threshold).



Figure 6-38. Negative ECG curve (negative polarity) with steep R-peaks
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You should enter the channel with the best signal quality among the recorded ECG channels

inthe ECG Channel text box.

Figure 6-39. R-Peak Trigger filter
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Summary

Settings

6.12 Segmentation

The Segmentation filter allows you to cut out segments of the complete data set of the EEG
on the basis of all markers or selected markers.

Note that in contrast to the Analyzer, it is not possible to select the marker names or marker
types (e.g. stimulus, reaction, instruction) from a drop-down list, as this information is un-
known to the program at the time the parameters are passed. Consequently, you must enter
the names and type descriptions manually. The entries are not case-sensitive.

Figure 6-40. Parameters dialog box for the Segmentation filter
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Select the markers to be used in the Markers group:
» Select the Use All Markers option to use all the markers in the data set.
» To use certain types of marker, select the Select Markers by Type option and enter the

required types in the relevant list. To use certain marker names, select the Select Markers
by Description option and enter the required names in the relevant list.

The Reset Types and Reset Descriptions buttons allow you to reset your entries for the marker
types or marker names.



The Interval Relative to Markers group allows you to specify the size of the interval to be seg-
mented relative to the markers. You can choose between a time-based specification (Based
on Time) and a data-point-based specification (Based on Data Points).

If you choose to use time-based intervals, you enter the boundaries and duration of the in-
terval in the text boxes Start [ms], End [ms] and Duration [ms].

If you choose to use data-point-based intervals, you enter the start and end points and the
number of data points in the text boxes Start Point, End Point and Points.

Check the Allow Overlapped Segments box to specify that overlapping segments are permit-
ted. If you do not check this box, markers are ignored that are too close to the previous mark-
er.

Figure 6-41. Segmentation filter
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The number specified in Segment Count (in the top left of the filter window) specifies what
segmentis currently being displayed. The "Time Zero" marker (dashed horizontal line) is also
displayed.

Figure 6-42. Display of the segment number and the "Time Zero" marker
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A segment that is detected is displayed until the next segment can be displayed in its entire-
ty. This means that only the current segment is ever displayed. °

Segmentation

Note that in contrast to the
Analyzer, the values for the
time-based text boxes are
not automatically convert-
ed to the corresponding
number of data points or
time points if you change
the specification method.
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7.1 MRI filter

If EEG data is recorded in an MR scanner, the signals are subject to considerable interfer- ~ Summary
ence.

In this context, we distinguish between two primary categories of artifacts:

1 Scannerartifact. A scanner artifact is caused by the alternating magnetic field during the
scanning process.

2 Cardioballistic artifact. A cardioballistic artifact is caused by the strong static magnetic
field combined with movements of the electrodes in time with the heart frequency of the
test subject.

The MRI artifact filter allows you to considerably reduce artifacts belonging to the first cate-
gory. The EEG signals then become clearly visible again and you can now identify saturated
channels or channels subject to other interference.

Correction is carried out on the basis of averaging. In principle, recurring intervals are aver-
aged in phase with artifact generation. This causes the randomly distributed EEG signals to
be dropped from the averaged curve, ideally leaving only the external influence of the scan-
ner. This is now used as a template and is subtracted from the individual sections in a sec-
ond step. What is left is the useful signal.

The MRI artifact filter is simple to use. However, the Time of Repetition (TR), i.e. the time be-
tween two consecutive gradients, must be exactly known to an accuracy of one sampling in-
terval.

Template drift compensation Initial methodological

considerations
Template drift is the temporal offset of the scanner TR relative to an integer multiple of the

sampling interval of the EEG amplifier. This happens either because the TR has not been
matched to the sampling rate of the amplifier or because the amplifier and the scanner have
a slightly different interpretation of the exact length of 3000 ms, for example. It is, for in-
stance, possible that the scanner in reality requires 3000.025 ms to complete a TR cycle. In
our example, this causes the data points of the subsequent TR to be measured 0.025 ms too
early. Thus, the measured values for the artifact in the data points of the subsequent TR no
longer exactly match those which are stored in the template. This has a negative impact on
the quality of correction.

Because the difference between the true TR of the scanner and the nominal TR of the filter is
constant for the whole duration of the measurement, each of these drifts adds up and, over
time, the quality of the template is destroyed.

Itis not possible to specify the TR with an accuracy greater than one sampling interval, as the
algorithm works with data points separated by one sampling interval. This means that even
if the TR is specified as accurately as possible, it is possible for an offset to arise.

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013
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The following diagram shows an example of template drift. The true TR of the scanneris one
third of a data point longer than the nominal TR. The top part of the diagram shows the times
at which data points are measured and how they are assigned to the template. The bottom
part shows the times at which the artifact repeats in reality. The value of the artifact at the
time at which the fourth data point of the fourth TR was measured (highlighted in the dia-
gram) is actually the value of the artifact at the time at which the third data point of the first
TR was measured. If this data point is included in the templates, without compensating for
the template drift, this results in a discrepancy.

Gemessane Datenpunkte aus Sicht des Filters

Zuordnung der Datenpunkle zum
Template der Lange TR

Die wahre TR des Artefakts ist um einen Drittel-Datenpunkt [&nger.

The MRI artifact filter is able to determine the template drift and also calculate which point
of the template a measured data point should be assigned to. If the template drift exceeds
the value of one sampling interval, then the start of the artifact is shifted by one or more data
points. However, interference still occurs because some TR sections are offset by a fraction
of the sampling interval with respect to the template.

The diagram shows how the filter compensates for the template drift in the fourth TR by shift-
ing the template in relation to the measured data points.

Gemessene Datenpunkte aus Sicht des Filters

Zuordnung der Datenpunkle zum
Template der Lange TR

Die wahre TR des Artefakts ist um einen Drittel-Datenpunkt [Enger.

In order to improve the quality of the correction still further, the filter actually uses several
templates. The template drift of the first point is determined for every section of the TR, and
only those data points from TR sections in which the template drift has a similar value are
included in each template. The individual templates can be seen as being "offset by a given
fraction of the sampling interval".

If several templates are used, the number of TR sections added to each template aftera spec-
ified period is reduced proportionally. The more TR sections a template contains, the more



MRI filter

meaningful the data will be that is corrected using this template. For this reason, the number
of templates used should not be too large; three is a suitable value.

The following diagram shows the filter with three templates and indicates which data point
is added to which template. Depending on the value by which the first point of a TR section
is offset in relation to the TR of the scanner, the data points are included in different tem-
plates. The top template contains data points with the template drift of 2/3 of a sampling in-
terval and the bottom template contains points with no template drift.

Gemessene Datenpunkte aus Sicht des Filters

Zuordnung der Datenpunkie zum
Template der Lange TR

Die wahre TR des Artefakts ist um einen Drittel-Datenpunkt [@nger.

Because the difference between the true and nominal TR is not generally an exact fraction of
the samplinginterval, it cannot be assumed that this method can completely compensate for
discrepancies arising from template drift. Nevertheless, the quality of the correction is im-
proved.

Template drift detection

The MRI artifact filter uses a procedure to automatically determine the template drift from the
data. This is necessary if the user does not know the exact value of the template drift. Tem-
plate drift detection works reliably if the TR is known to an accuracy of one sampling interval.
Scannertiming discrepancies greater than one sampling interval can be compensated for by
setting an adjusted TR.

The template drift is determined by observing the marked, narrow peaks in the data. A peak
of this type cannot come from the normal EEG signal, as this does not generally have gradi-
ents of a comparable magnitude.

By comparing the positions of the peaks of different TR sections, it is possible to determine
the template drift between the sections in real-time, even if a TR section has only been par-
tially read.

This method is particularly suitable for comparing consecutive TR sections. Because tem-
plate drift is the result of a constant discrepancy between the scanner and the amplifier, it
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Basic settings of the MRI arti-
fact filter

remains constant between two consecutive TR sections. As a result, the average can be
drawn across a large number of individual measurements of the template drift, giving a value
which is not subject to temporary interference in the data. The template drift with relation to
the measured artifact can be determined subsequently for a TR section which has already
been read. This is achieved by adding the section-to-section drift to the known drift of the
previous section and also by directly calculating the template drift in relation to the first TR
section measured. Combining these values permits accurate determination of the template
drift.

In order to assign the measurement data of the new TR section to a suitable template from
the very start, the template drift of the section must be known before the data is measured.
However, at this time the template drift of the TR section which has just been processed is
known, as is the template drift between two consecutive sections. The template drift of the
new section can be predicted on the basis of these values.

Figure 7-1. Parameter dialog box for the MRI artifact filter
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The TR [ms] text box specifies the time of repetition.

In the Number of Templates text box, you can specify how many templates the filter estab-
lishes in order to improve correction quality in the event of template drift. This value should
be 1 if there is no template drift. If there is template drift, a value greater than 1 can improve
the correction quality. However, because each TR interval is only incorporated in one of these
templates, a higher value here means that it takes longer until the templates become mean-
ingful. A sensible value is 3.

In the Ignore Channels in Correction text box, you can specify a comma-separated list of
channel names which are not to be corrected by the filter.

You are also able to reduce the sampling rate of the corrected data after the actual scanner
artifact correction has taken place in order to increase the speed with which the subsequent
nodes in the filter tree can work. Downsampling Ratio is the factor by which the sampling
rate is reduced. For example, a value of 20 means that a 5000 Hz signal is converted to a 250
Hz signal.



The reduced sampling rate data is fed through a Butterworth low-pass filter in order to re-
move remaining noise. The Filter Frequency and Filter Slope text boxes specify the filter fre-
quency and the slope of the characteristic curve of the filter.

Advanced settings which only rarely need to be changed are available if you click the
Change... button.

Figure 7-2. Advanced configuration of the MRI artifact filter
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(™ Use Constant Template Drift
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[+ Enable Automatic Template Resets
Reset Threshold [*%]: 1
Maximum Gap Fill [TRs]: 2

If the TR has been specified correctly, the default settings for automatic template drift detec-
tion are as a rule suitable for processing the data reliably. However, it is possible that modi-
fications need to be made for particular sets of measurement data in order to adjust the
method to the particular conditions that apply to this data.

Select the Automatically Detect Template Drift option to use automatic template drift detec-
tion.

In the Ignore in Drift Detection [Channel List] text box, you can specify a list of channel
names which are not to be used for drift correction. The list is separated by commas. This al-
lows you to prevent individual channels with extremely atypical data from negatively impact-
ing the template drift detection process.

The Size Threshold [uV] parameter specifies the minimum size of the peaks which are used
for template drift detection.

The Bracketing Threshold [uV/ms] text box specifies the gradient that delineates the peaks
from the neighboring data points. Minima are only used if this gradient is exceeded. It can
be necessary to reduce the values in these boxes if the overall strength of the artifacts or the
typical artifact gradients are lower than the default values.

Advanced settings

MRI filter
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We recommend that you al-
ways use automatic tem-
plate drift detection and
adjust your settings accord-
ingly. Even if the drift is
known in advance, the auto-
matic detection facility can
be useful in order to com-
pensate for discrepancies
that occur over time.

Select the Use Constant Template Drift option to deactivate automatic template drift detec-
tion. This only makes sense if drift correction fails on the measured data or if the template
drift is known in advance with a high degree of accuracy.

If automatic template drift detection is deactivated, you can specify a constant drift between
two consecutive TR sections in the Drift Value [% of Sampling Interval] text box. The drift is
specified as a percentage (negative or positive value) of a sampling interval. A value of -30
would mean that the nominal TR of the filteris 30/100 of a sampling interval shorter than the
actual TR of the scanner.

If you check the Enable Automatic Template Resets box, the filter automatically rebuilds its
templates if changes in the artifact cause the correction quality to drop below a particular
value. You should deactivate this automatic facility if the filter rebuilds its templates when
this is not required. You can rebuild the templates at any time by clicking the Reset Averag-
ing Templates m button in the toolbar.

The correction quality is determined on the basis of the proportion of large gradients remain-
ing in the corrected data. If there are a large number of high gradients in the corrected data,
this is an indication that the artifact has not been removed reliably. It is however possible
that some large gradients remain in data which has nevertheless been corrected sufficiently
well. The Reset Threshold [%] text box allows you to specify the percentage of data which is
permitted to contain large gradients.

If the filter encounters gaps in the measurement data, this is an indication of temporary over-
loading of the computer on which you are running the program. The filter will attempt to
bridge a gap of this type to avoid aborting the current correction. The value in the Maximum
Gap Fill [TRs] text box specifies the maximum number of TRs that are bridged.



Figure 7-3. MRI artifact filter
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7.2 Pulse-artifact filter

The Pulse-artifact filter detects the heartbeats, i.e. the R-peaks on a specified ECG channel,
and initiates a correction process for the EEG channels for every detected pulse period. The
functionality of the filter falls into the following phases:

Downsampling

Sinceitis necessary forthe filter to process a large quantity of input data in a relatively small
time, its performance improves inversely to the sampling rate of the input data. For this rea-
son, the filter has an optional preprocessing stage that allows you to reduce the sampling
rate of the input data.

The training phase

In order to detect the position of the R-peak on the ECG channel, the Pulse-artifact filter must
find and store a pulse pattern with a distinct R-peak. This is done within a fixed period when
the filter first starts to be used. This period is referred to as the training phase in this docu-
ment. The default value for the duration of the training phase is 15 s. You can change this

Summary

Pulse-artifact filter
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duration. During the training phase, the pulse is neither marked nor corrected. If no pulse
pattern is detected after the planned training phase, the training phase is repeated with ref-
erence to the following sections until a pulse pattern is successfully detected.

Pulse detection

After the training phase has been completed, the actual pulse detection process starts. This
involves a combined procedure using correlation and amplitude criteria that compares the
period of the pulse pattern with the current period. If the correlation lies above a previously
defined limit and the amplitude lies within previously defined limits, an R-peak marker is set
at the position on the time axis at which the R-peak was set in the pulse pattern.

Correction

The pulse artifacts are corrected simultaneously on all EEG channels that you have not ex-
cluded from correction. During this process, a period defined by entering a time prior to the
R-peak and a time after the R-peak is corrected. In order to correct this period, a template is
used which is derived by averaging the previous pulse periods and then selecting this value
from the current data period.



Figure 7-4. Parameters dialog box for the Pulse-artifact filter

Pulse-artifact Filter Parameters

Detection Parameters

Minimal Pulse Period (ms): 750

¥ Mark Pulse Peaks.

Suppress Marker Display
¥ Hide Markers with Description(s):

Pulse Reference Channel: EKG2 Number Pulses in Average: 10

Look for a Model Pulse [s]: 15 Correction before Peak (ms): 100

Minimal Correlation: D&

Minimal Amplitude: 02 Diownsampling before Correction
Maximal Amplitude: 18 ¥ Do Downsampling.

Carrection Parameters

Correction after Peak (ms): 600

Excluded from Correction:

[V Downsampling to 250 Hz.

Downsampling with a Factor of:

[R128, Rl

You can configure the pulse detection parameters in Detection Parameters:

Pulse Reference Channel:

Look for a Model Pulse (s):
Minimal Pulse Period (ms):

Mark Pulse Peaks (check-
box):

Minimal Correlation:
Minimal Amplitude:

Maximal Amplitude:

ECG reference channel. RecView checks whether a valid chan-
nel has been specified and outputs an error message if the
channel is not present. The error message also indicates
which channel will be used instead of the missing channel,
namely the last channel in the workspace's channel table.

Length of the training phase

Minimum distance between two R-peaks

Specifies that detected R-peaks are to be marked with R mark-

ers
Contains the correlation threshold (default: 0.6)

Contains the lower amplitude threshold (default: 0.6).
Contains the upper amplitude threshold (default: 1.2).

Correction Parameters Contains the correction parameters:

Number Pulses in Aver-
age:

Correction Before Peak

(ms):

Correction After Peak (ms):

Number of preceding pulse beats that are to be taken into
account for the currently used correction template (default:
10).

Distance between the start of the correction interval and the
R-peak.

Distance between the R-peak and the end of the correction
interval.

Settings

Pulse-artifact filter
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Excluded from Correction: Channels that are not to be corrected. Enter a comma
between the channel names. It is usual to exclude the ECG
channels from correction to make it easier to identify
whether the R-peaks are set correctly or whether the detec-
tion or correction parameters need to be adjusted.

Under Downsampling before Correction, you can use

Do Downsampling: To specify whether downsampling is to be performed as a
preparatory step or not. If you check this box then the
Downsampling to 250 Hz checkbox is also activated.

Downsampling to 250 Hz:  If you check this box then the sampling rate is automati-
cally reduced to 4 ms (250 Hz). Alternatively, enter the
downsampling factor you require as an integer in the
Downsampling with a Factor of text box.

You can use Suppress Marker Display to hide markers:

Hide Markers With Descrip- Check this box if you want to hide specific markers in

tion(s): RecView. Enter the marker name in the Suppress
Marker Display text box (e.g. R128). If you enter
more than one marker name, separate the names
with commas. Any markers you hide in this way are
not removed but are simply no longerincluded in the
display. As a result, you can continue to use these
markers, for example when performing subsequent
segmentation.



Figure 7-5. R-peak marker and correction of a channel
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Downsampling is mandatory for inputs of 5000 Hz and more if the filter is to function effi-
ciently. We also recommend automatic downsampling to 250 Hz in this case.

If incorrect R-peaks are to be marked, enter a higher value in the Minimal Pulse Period (ms)
text box. If this does not result in any improvement, increase the value in the Minimal Cor-
relation text box by one tenth (e.g. from 0.7 to 0.8) or reduce the value range of the accept-
able amplitude correlation (e.g. from 0.6 to 1.2 to 0.7 to 1.1, etc.).

If R-peaks are skipped, reduce the value in the Minimal Pulse Period (ms) text box. If this
does not result in any improvement, increase the value in the Minimal Correlation text box
by one tenth (e.g. from 0.7 to 0.6) or reduce the value range of the acceptable amplitude cor-
relation (e.g. from 0.6 to 1.2 to 0.5 to 1.3).

If the R-peaks are identified correctly, but the artifacts are not corrected, the selected correc-
tion interval is too coarse. The Pulse-artifact filter does not permit any overlapping correction
periods. This means that the sum of the values Correction before Peak and Correction after
Peak must be smaller than the minimum actual period between two successive R-peaks.

Because the pulse artifact template is not continuously rebuilt despite the fact that the rest-
ing pulse of the test subject may change during measurement, it could be helpful to reset the
template. You can rebuild the templates at any time by clicking the Reset Template in Pulse-
artifact Filterﬂ button in the toolbar.

Pulse-artifact filter

Notes on use
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Chapter 8 Programming user-defined filters

Chapter 8 contains programming instructions for developing user-defined filters. Please
note that Brain Products is unable to provide any support with respect to implementation
details. We shall supply descriptions and examples of filter implementations.

8.1 Overview

You can extend RecView to include filters you have programmed yourself. Filters are made up
of program libraries that use the Microsoft .NET runtime environment.

The following requirements apply if you wish to develop your own filters:
» Ageneral knowledge of programming.
Knowledge of a .NET programming language; our examples use C#.

>
» Understanding of the terms "interface", "class" and "attribute" in the context of .NET.
>

A development environment for .NET components for .NET Version 4.0. Our sample proj-
ects were developed using Microsoft Visual Studio 2010.

Copy the compiled filter DLL into the program folder so that RecView is able to find it.
You will find help and examples in the folder RecView\Filter Development on the BrainVision
program DVD.

Afilteris always implemented in the form of a collection of interfaces within a class. A special
filter attribute describes the filter for RecView.

The interface and structure descriptions and the filter attribute class are contained in the file
Recorderinterfaces.dll, which is located in the program folder. This must be referenced in all
filter projects.

You will find a precise description of the structure of the interfaces, classes and attributes in
the help file RecViewlnterfaces.chm located in the subfolder Filter Development.

For notes on debugging user-defined filters using Visual Studio 2010 Express C#, see the file
Debugging RecView Filters with Visual Studio 2010 Express Edition C#.pdf in the Filter De-
velopment subfolder.
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8.2 Interfaces

The following interfaces can or must be implemented:

IDatalIn (mandatory)

This interface is mandatory. It receives the data, setup information and status information
from the previous filter.

IDataOut (optional)

If the results of the filter are to be passed to RecView so that they can be viewed or distribut-
ed to further filters, you must implement this interface. It establishes the connection be-
tween the filter and another IDatalIn interface supplied by RecView.

IFilterParameters (optional)

This interface allows you to enter parameters. Parameters are stored in text format in the
workspace file by RecView. The interface receives or supplies the text and displays a user di-
alog box on request.

ISimpleView (optional)

This interface is used for simple visualization of data. The data is displayed in a window out-
side the RecView frame using the methods of the interface. If you have implemented this in-
terface, you cannot implement the IDataOut interface. This means that the filter represents
an endpoint in the filter tree.

IDataView (optional)

This interface is also used for visualization, but has a far more complex structure. It inte-
grates visualization into RecView itself. It is also able to handle the existing buttons for scal-
ing and setting the time etc. Because it is so complex, we shall not deal with the IDataview
interface here. We recommend that you use ISimpleView instead.

IUITools (optional, "UI" = "User Interface")

This allows you to provide users with buttons on a toolbar in order to perform corrections in-
teractively, forinstance. You can also output information in one of the fields of the status bar.



The following paragraphs list some examples of filters using different interface combina-
tions:

>

The frequency filter uses the interfaces IDataIn, IDataOut and IFilterParame-
ters. If this filter only allowed fixed frequencies, it would not be necessary to use the
IFilterParameters interface.

The map implements IDataIn, IDataOut, IFilterParameters and IDataView.
IDataView is implemented because RecView is not able to represent topographical
data implicitly.

The MRI artifact filter implements the interfaces IDataIn, IDataOut, IFilterPa-
rameters and IUITools. IUITools is used to allow the user to reset the template
used while the data is being displayed.

A simple biofeedback filter can be implemented using a combination of IDataIn and
ISimpleView. You will find an example of this on the BrainVision program DVD in the
folder Filter Development\Samples\SimpleViewExampleFilter below the RecView folder.

You can also develop a filter which only implements IDataIn. The data can then, forin-
stance, be exported over the serial interface. You could also write the data to hard disk.
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If you want to use the exam-
plesin debug mode, you will
find therelevant information
in the file Debugging
RecView Filters with Visu-
al Studio 2010 Express
Edition C#.pdfin the Filter
Development subfolder on
the BrainVision program
DVD.

8.3 Programming examples

The sample projects are located in the RecView\Filter Development\Samples folder on the
BrainVision program DVD.

Compiled versions of the projects are located on the DVD in the folder RecView\Filter Devel-
opment\Samples\Binaries. If you wish to test these projects, copy them to the program fold-
er.

Sample filter 1

We shall look at the filter in the subfolder RecView\Filter Development\Samples\FlatChan-
nelFilter in detail below. While you are reading the following explanations, you should have
the help file Recorderinterfaces.chm open.

Itis usually possible to compile the project without difficulty using Microsoft® Visual Studio
2010. You may have to adjust the reference to RecViewlinterfaces.dll in the project, since it
could reference an invalid folder. Do this by deleting the reference and then creating it again,
specifying the correct path. As we have already said, the file is located in the RecView pro-
gram folder.

The job of this filter is to allow a channel selected by the user to be deactivated, i.e. all the
values on the channel are set to 0.

Here, we shall look at the file TestFilter.cs containing the class TestFilter.

The class contains one filter attribute. Without this attribute, RecView would ignore the class.
The first element of the attribute (id) is a GUID. This is a 128-bit value which uniquely iden-
tifies the filter. If RecView finds several filters with the same GUID, only the first of these is
loaded. You should therefore generate a genuine GUID in Visual Studio, for instance by
choosing Tools » Create Guid.

The displayName parameter defines the text which appears in menus etc. Description
is a short help text.

The next four parameters describe which input and output data types and which segmenta-
tion types are permitted. In our example, we have the type DataTypes.TimeDomain for
both input and output data type. This means that the filter expects and returns data from the
time domain. The permitted input segmentation types are described by Segmentation-
Types.Continuous|SegmentationTypes.Segmented. This means that the filter can
use both continuous and segmented data. The output segmentation type is identified by the
designation SegmentationTypes.DefinedByParent. This segmentation type indi-
cates to the program that the output segmentation type is determined by the input type, i.e.
the output type of the upstream filter. The same logic must be used if you use a filter with a
multi-value input and output data type. You will find a list of available data types and seg-
mentation types with descriptions in the file RecViewinterfaces.chm.



The following parameters are reserved and must be set to 0. The last (and optional) filter at-
tribute indicates whether the filter directly addresses hardware components. In this case, it
does not matter whether you omit the attribute or set it to the value HWAccess . None. If you
wantyourfilterto access the parallel port, you should set the value to HWAccess . LPTPort.
If RecView detects a filter whose hardware access attribute has this value then the RecView
LPT port status display becomes visible.

The IDataOut interface receives an IDataln interface via the Connect () method. This
interface is stored in the private variable dataReceiver. The Connect () method is al-
ways called before any other method of the IDataIn interface.

The methods of the IDataIn interface forward the parameters passed to them to dataRe-
ceiver. Dependingonthe taskinvolved, these parameters may be modified or unmodified.
In our example, the setup is modified in IDataIn.Start () inorderto change the name of
the channel whose values are to be set to 0. The modified copy is then forwarded to
dataReceiver. IDataIn.AddData () also selects the same procedure, namely modifi-
cation of a copy, for the received data.

Never modify the original data if this was passed in the form of an object reference. Any
change might affect other filters.

The IFilterParameters interface receives and returns a text via the Parameters prop-
erty. This text can easily be converted to and from parameter variables using the xm1Seri-
alizer class of .NET.

IFilterParameters.EditParameters () opens adialog box where the user can enter
parameter variables.

Sample filter 2

Another example filter, the SimpleViewExampleFilter already mentioned, displays a
"smiley" whose smile depends on the proportion of alpha waves in the total spectrum of the
EEG. The proportion of alpha waves is also displayed in numeric form on the top left of the
output window.

This filter only accepts complex frequency data as supplied by FFT. This means that frequen-
cy analysis within the filter is extremely simplified, because the FFT filter has already convert-
ed the data to frequency data.

In this case, the IDatalIn interface is implemented as well as the ISimpleView interface.
The window in which the data is displayed is not bound to the RecView interface, but can be
moved freely. This allows you to use the entire screen for biofeedback output.
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Sample filter 3

The final example - ExampleParallelPortAccess —illustrates how the parallel port can
be controlled using a filter which you define yourself. Your filter does not need to implement
any interface in order to control the parallel port.

Instead, you simply need to use the methods of the class ParPortAccess which is present
in the file RecViewlnterfaces.dll. Use the public methods

bool Init(InfoProvider info, out string sMessage),
ParportAccess.Write (byte signal) and

byte ParPortAccess.Read () as described inthe example.

Note the use of a constructor with Infoprovider-Delegate as parameter. If you want to
make use of the possibility of monitoring the operation of your filter in the RecView LPT port

status display, add the entry HWAccess.LPTPort to your filter attributes as in the exam-
ple. Please note that you need administrator permissions in order to use this type of filter.
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Appendix A Electrode coordinate system

The electrode coordinate system used in RecView is explained below. This coordinate system
is used wherever electrode positions are needed, e.g. in mapping.

The axis system is defined in such a way that the z-axis runs through the vertex. The x-axis
points to the right, and the y-axis to the front.

Spherical coordinates are used to specify a point on the head. A set of coordinates consists
of the three variables r, 6 and ¢ (radius, theta and phi).

The radius r specifies how far the point is away from the center of the coordinate system. It
is stated in millimeters. The only exceptions are r= 0 and r= 1. r = 0 signifies an invalid po-
sition, for instance when the position of an electrode is not known, r = 1 means that a stan-
dard diameter has been chosen for the radius. This can be used when the surface of the head
is approximated by the surface of a sphere.

¢ specifies the angle between the x-axis and the projection of the line connecting the point
and the coordinate origin on the xy plane. ¢ > 0 applies to the front right and rear left quarter
of the sphere and ¢ < 0 to the front left and rear right.

0 is the angle between the z-axis and the line connecting the point and coordinate origin. In
the left hemisphere, 6 < 0. In the right hemisphere, 6> 0.
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Figure A-1. Coordinate system for electrodes
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Appendix B Installing the RecView license from the Brain
Products web site

RecView can only be used if you have purchased a sub-license for the Recorder. If you pur-
chased sub-licenses at the same time as you purchased the Recorder, the sub-license file is
included on a USB data carrier supplied with the software. All sub-licenses that you have pur-
chased can be downloaded from the Brain Products web site.

Appendix C describes how to download and install sub-licenses that you purchase subse-

quently.

To activate the downloading of sub-licenses, your USB dongle must first be registered. Todo ~ Downloading sub-license files
this, choose Downloads & Support > Product Registration at www.brainproducts.com.

To register your dongle, enter the external and internal serial ID of your dongle, your name,
university and email address in the product registration form (see Figure B-1). The external
serial ID is printed on your dongle. You can find out the internal serial ID using the Serial ID
Check Program available on the web site. “@ Further information is available at www.brain-
products.com/productreg.php. Once your registration has been processed, you will receive

a confirmation mail.

Figure B-1. Data entry form for product registration

Product Registration

Dongle Driver

About Brain Products
Type: zip Size: 9.9

Serial ID Check Program
Type: Zip Size: 289.1 KB

Hardlock number (will be used as username)® Serial ID (will be uzed as

Distributo | | |
Downloads & Support itle & Name University / Institute / Dep
Overview
Product Registration Emait Postal Address
Downloads
Order & Return Shipment

| *flds are mandatory

Reqgister

After you have received the confirmation mail, you can log in (see Figure B-2) to download
your files by proceeding to the Login page. Use the login data you received by mail.
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Installing sub-license files

Figure B-2. Login form

Home
About Brain Producls Usermame
URATD125
Projects & Referenc
Password

Workshops & Events = e

X X seseee

& Applications
Login

Downloads & Support
Order & Return Shipment If you do not have a login yet, please register here. If your login doe:

Please note that cookies have to be accepted to login.

Now you can select and download the sub-license file License File for Analyzer 1 and/or Re-
corder from the download area under Downloads & Support » Downloads (see Figure B-3).

Figure B-3. Download area for sub-license files

pads & Support
#

= Register your product here

t Reqgistration R
BrainVision Analyzer 2 =
rads

Brain'ision Analyzer =
Return Shipment 2

BrainVision Recorder =
Brainision RecView =
Dongle Driver =

Electrode Caps =

tributars
Manuals =

Tutorials & SetUp Poster=
Scripts & Tools =

Brain Products License Files

_-_IE__I‘_ License File for Analyzer 1 and/or Recorder
s Type: exe Size: 118.2 KB

A sub-license file is an executable file. It automatically installs the sub-license in the correct
folder.

Start the executable file and then click Continue to install the sub-license (see Figure B-4).
Then follow the instructions in the automatic installation routine.
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Figure B-4. Installing sub-licenses

]
E BrainProducts-License-20090108-1408

This program will install the Brain Products
License file,

You can check what sub-licenses are active by choosing Help » About BrainVision Recorder...
from the Recorder menu (see Figure B-5).

Figure B-5. Displaying sub-licenses in the Recorder

Ef Recorder

File View Display Montage Cenfiguration Window | Help |
0wl | ol « 8] &lal 2)—]=] i /=]

Show Installed Components...

. About BrainVision Recorder...

: —

== BrainVision Recorder Version 1.20
Copyright® 2000 - 2009 Brain Praducts GrbH

Swystem Info

Hazp HL 5/M: 102151 [Analyzer/Recorder combined dongle]
Sublicenses:

Wigion Yideo

WVigion RecWiew

Wigion RecWiew MRl Comection

The installed sub-license is stored in the Windows® system folder as a file with the exten-
sion .bplcs. ®
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Appendix C How can I find the address of the LPT port?

If your computer has only one parallel port (LPT1) then its hardware address is usually 0378
(default value). If you computer has a second parallel port then its hardware address is usu-
ally 03F8.

If the default address is not the correct address then you can identify the address as follows:
1 Openthe Windows® Device Manager.
2 Inthe Device Manager, choose the entry Ports (COM and LPT).

3 Todothis, right-click the line ECP (LPTx) Printer Port and choose Properties from the con-
text menu that appears.

4 The dialog box ECP Printer Port (LPTx) Properties appears.
5 In this dialog box, choose the Resources tab (see Figure C-1). You can see the first start

address in the I/0 range under Resource Settings.

Figure C-1. Displaying the address of the LPT port in the Windows® Device Manager

Eigenschaften von ECP-Druckeranschluss (LPT1) |E| E|

Allgemein | Anschluszeinztellungen | Treiber Detailsl Ressourcen

(3 ECP-Druckeranschluss [LPT1]

Resrourceneinstellungen:

Ressourcentyp Einstellung
DM 03
Wl E /2 -Bersich 037F
WME /5 Bereich 0778-077F

Automatisch konfigurieren
Geratekonflikt:

Keine Kanflikte.

ok | | Abbrechen
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Appendix D Behavior of TTL pulses in different parameter
configurations

On page 143 of Appendix E, you will find a diagrammatic representation of the behavior of
the TTL pulses in response to different parameter configurations of the Band Power Trigger
filter (see also @ Section 6.2 as of page 81) and Level Trigger filter (see also @ Section 6.7

as of page 96).

A: "Hysteresis" mode

—Trigger Configuration
" Discrete TTL-Pulses

* Hysteresis

Set TTL | TTL Value [hex]

»  Upper Threshold Excesded

TTL-Pulse Length [ms]:

¥ Inhibit zdditional TTL-Pulses for
Inhibition Period [ms]:

(The curve at pin O is displayed.)

The depictions in B and C indicate the settings you can make to prevent signals from being p
overwritten prematurely.

B: "Discrete TTL-Pulses" mode without inhibition period

—Trigger Configuration
* Discrete TTL-Pulses

" Hysteresis

Set TTL | TTL Value [hex]

¥ Upper Threshold Exceeded
Lower Threshold Under-Run 2 02

TTL-Pulse Length [ms]: I‘IDD

[ Inhibit additional TTL-Pulses for:

Inhibition Period [ms]: I'I 0Do

(The curve at pin 0 and pin 1 is displayed.)
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C: "Discrete TTL-Pulses" mode with specified inhibition period

— Trigger Configuration
' Discrete TTL-Pulses

™ Hysteresis

Set TTL | TTL Value [hex]

*  Upper Threshold Exceeded

Lower Threshold Under-Fun v 02
TTL-Pulse Length [ms]: I‘IDD
[# Inhibit additional TTL-Pulses for:

Inhibition Period [ms]: I'H}[H

(The curve at pin 0 and pin 1 is displayed.)

D: "Discrete TTL-Pulses"” mode with specified inhibition period

—Trigger Configuration
& Discrete TTL-Pulses

" Hysteresis

Set TTL | TTL Value [hex]

»  Upper Threshold Exceeded Iv|
Lower Threshold Under-Run I 02
TTL-Pulse Length [ms]: I'IDD
[ Inhibit additional TTL-Pulses for:
Inhibition Period [ms]: I.u)n

(The curve at pin 0 is displayed.)

s You should note that the accuracy of the reset timer and the inhibition period timer depends
on the resolution of the Windows® internal system clock. It is therefore not possible to guar-
antee that timing will be accurate to the nearest millisecond.
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Figure D-1. Diagrammatic representation of the behavior of TTL pulses
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Appendix E Legal notes

WinRing0

RecView uses the WinRingO library from OpenLibSys.org in order to control the parallel port.
In compliance with the conditions of the modified BSD license, we reproduce the redistribu-
tion conditions here. The Copyright text refers only to the WinRingO files present in the dis-
tribution (WinRing0.dll, WinRing0x64.dll, WinRing0.sys, WinRing0x64.sys, WinRing0.vxd):

Copyright (c) 2007-2009 OpenLibSys.org. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of condi-
tions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of con-
ditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WAR-
RANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUEN-
TIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Notes for RecView users in the USA

You should note that the use of our devices and software other than for the intended use de-
scribed in the present User Manual may represent an infringement of certain industrial prop-
erty rights arising out of US patent number 5,445,162. You should therefore note that the
following procedures for use must be observed.

Recording must be performed outside the MRI room. The PC or laptop used to record and
store the signals must not be located in the MRI room. Brain Products GmbH accepts no lia-
bility in the event of any non-compliance with these instructions and the original intended
use.

We accept no liability for loss or damage caused to your devices by strong magnetic fields if
laptops or computers are located in the MRI room. This does not just apply in the USA, but
worldwide.

The manual or automatic triggering of the MRI based on the detection of special wave forms
during the monitoring of inbound data may potentially result in the infringement of patent.
Brain Products GmbH accepts no liability or responsibility in the event of the improper use of
our devices and/or software for such purposes.

The BrainAmp MR and BrainAmp MR plus amplifiers and the BrainVision Recorder recording
software are not able to send triggers based on the detection of special wave formsin an EEG
(e.g. spikes). You can find further information on the US patent office's web site at http://
www.uspto.gov (patent number 5,445,162 and referral). Alternatively, please contact Brain
Products GmbH directly.

BrainVision RecView is able to send triggers. The use of this function within the framework of
the above-mentioned patent-protected procedure should be avoided in the USA. You can
find further information on the US patent office's web site at http://www.uspto.gov (patent

number 5,445,162 and referral). Alternatively, please contact Brain Products GmbH. [
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List of abbreviations

BCl ceeeeeeeeeeeeeeiee Brain Computer Interface

CE e, Conformité européenne (European Conformity)
ECG torrereeeeeeeeeeeee Electrocardiogram

EDA oo, Electrodermal activity

EEC cooieeeeeeeeeeeeee European Economic Community

EMG oo Electromyogram

EOG .ooveerreeeeeeeeeene Electrooculogram

EU s European Union

N Fast Fourier Transform

fMRI e Functional magnetic resonance imaging

ICA e Independent Component Analysis

[EC ot International Electrotechnical Commission
LDR oot Linear derivation

LORETA ..ovrrreeeeeeeeiinns Low Resolution Brain Electromagnetic Tomography
1 Line Print Terminal

MNI e, Montreal Neurological Institute

MRI ceveeereeeeeireeeeeenne Magnetic Resonance Imaging

ROI coeeeeeeeeeee e Region of Interest

TCP/IP eeeeeeeeeeeeenieeens Transmission Control Protocol/Internet Protocol
TR e, Time of Repetition

TTL ceeeeireeeeeeeeenneees Transistor-transistor logic
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Glossary

A

actiCAP ControlSoftware: Software from Brain Products that
allows the actiCAP active electrode system to be controlled
and configured. The actiCAP ControlSoftware can also be
controlled from the Recorder.

Amplitude: Maximum deflection of the EEG curve in pV mea-
sured from peak to trough.

Analyzer: Software from Brain Products for analyzing EEGs
and other physiological signals and which is able to read
and evaluate different file formats from various vendors.

Artifact: All potential shifts in the EEG recording that do not
have their source in the cortex. Artifacts can be subdivided
into those related to the test subject (physiological artifacts)
andtechnicalinterference. Technical artifacts can be caused
by faulty electrodes, defects in the apparatus or technical in-
terference.

Average: Formation of arithmetic mean using segmentation
(total value of the points divided by the number of seg-
ments). This is performed separately for each EEG channel.

Average: see DELETE THIS MARKER.

Baseline: An assumed horizontal line marking the vertical
zero point in the EEG (voltage = 0).

Bipolar connection: Montage type in which the differences
between two channels are calculated (see also Montage).

BrainAmp family: Amplifiers from Brain Products with 32
channels each (can be extended) that can be used in differ-
ent fields (laboratory acquisition, combined EEG-fMRI mea-
surements, EEG-TMS measurements, etc.).

D

Digital port: Parallel interface over which data can be trans-
ferred between a computer and peripheral devices.

Dongle: Pluggable copy protection device.

Drift: Drifts are temporal shifts between the averaged arti-
fact curve and the scanner artifact of each interval. This drift
is caused when the time of repetition (TR) of the scanneris

BrainVision RecView User Manual | Software Version 1.4.3 | September 30, 2013

not a multiple of the sampling rate of the amplifier. Conse-
quently, the artifacts of the individual intervals drift by a

fraction of a sampling interval even if the "Scan Start" mark-

ers are positioned perfectly.

H

High-cutoff filter: Filter that reduces the amplitude of high-
frequency digitized signals.

Impedance measurement: Recorder operating mode for
measuring the resistance of the electrodes.

Impedance: Resistance between the electrode and the head
skin.

Interval: A section of the EEG signal defined by its starting
point and length or by its starting point and end point within
the signal.

L

Low-cutoff filter: Filter that reduces the amplitude of low-fre-

quency digitized signals.

LPT port: see Parallel port.

M

Marker: Markers indicate a point in time or a period within
the EEG. A marker can be an item of stimulus information
that is used to ascertain evoked potential. It can also mark a

new segment or indicate that a DC offset correction was car-

ried out at a certain time. Markers are used for orientation
during segmentation.

Monitoring: Observation of the EEG signals on screen.

Montage: Reconnection of the channels in the software
whereby new voltage references are assigned to the chan-
nels.
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P

Polarity: The polarity setting determines whether the axis for
positive measurements points up or down on EEG curves.

R

Raw file: The EEG file obtained directly during recording
without any modifications.

RDA (remote data access): Remote access to the Recorder or
the transfer of data from the Recorder to RecView. In this pro-
cess, the Recorder acts as the serverand RecView as a client.

Resolution: Specifies the granularity with which the value
range of the EEG signal is subdivided during digital acquisi-
tion. A higher resolution means finer granularity and more
accurate acquisition of the original signal. Unit: pV.

S

Sampling rate: Number of data points measured per second
when acquiring an EEG digitally.

Scaling: In the context of displaying the EEG signal, scaling
is the assignment of an amplitude value in pV to an interval.

Segment: A section of the EEG resulting from segmentation
(g.v.).

Segmentation: Subdivision of the EEG into different seg-
ments (epochs). Segmentation can be based on a number of
different criteria. On the one hand, segmentation is under-
stood to be a preliminary stage in the analysis of evoked po-
tentials. Epochs of the same length are generated relative to
a reference marker (a stimulus, for example). This results in
a data set consisting of a sequence of segments or epochs.
On the other hand, segmentation is understood to be the
preparation of separate processing steps for different sec-
tions of an EEG, for example for the analysis of different stag-
es before and after medication.

Server: The address of the computer on which the Recorder
software is running (see also RDA).

Sub-license: File associated with the dongle and which can
be used to enable optional functions; Extension: .bplcs.

T

Ten-ten system (10-10 system): One additional electrode is
positioned between each of the electrodes of the 10-20 sys-
tem (q.v.).

Ten-twenty system (10-20 system): Internationally recog-
nized, standardized method for positioning electrodes on
the head. The skull is measured from defined anatomical
points. The distance between neighboring electrodes is ei-
ther 10% or 20% of the measured distances.

Trigger: Pulse generated by a device or software program
and which initiates an operation. A presentation software
package can, for example, generate a trigger each time an
image appears. The trigger can be sent to the amplifier via
the parallel port of the computer and recorded by the Re-
corder as a marker simultaneously with the EEG. EEG activity
(e.g.an EEG signal of sufficient amplitude or length) can also
be usedto generate a trigger pulse that starts a process (e.g.
control of a program).

TTL pulse: Transmission to the LPT port of a trigger signal
which is reset to the value 0 after a (relatively) short period.

TTL signal: Transmission to the LPT port of a trigger signal
which persists though to the reception of a given reset event
atthe LPT port; when the reset event is received, the value is
reset to O.

v

View: Method of representing the EEG, such as the grid view,
the head view, and the mapping view. A view determines
how the channels are arranged in the window, for example.

w

Workfile: A file containing information on workspaces
(*.rvwksp), montages (*.mont) and other user-defined set-
tings.

Workspace: Storage location for files, the processing steps
performed at the EEG data. File name extension: .rvwksp.



Subject index

A

actiCAP ControlSoftware 87
Administrator mode 58, 81, 96, 115, 138
Analyzer 25, 75, 92, 100, 102, 118, 119
artifact (see also scanner artifact and cardioballistic artifact)
88, 92
averaging 78
pulse artifact correction 128
scanner artifact correction 121
weighted 79
axes
configuring 69
subdivisions 70

bandwidth 94

baseline correction 44, 68, 79
block indicator 45

Butterworth high-cutoff filter 125

C

cardioballistic artifact 121
correcting 127-131
channel
activating/deactivating 5o
creating 85, 100, 100-102
reconnecting 85
coefficient matrix 100, 101
Command line options 64
coordinate system
for electrodes 139
forvoxels 104

D

data loss 45

data representation
configuring 44
incorrect 60-61
simultaneous 49

downsampling 127, 130, 131

E

ECG 116
channel 68, 117, 127
data 115

electrode
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changing position 73, 111
coordinate system 139
detecting gel bridges 87
preparing 89-90

F

FFT (Fast Fourier Transform) 91
data window 92
filter tree 53
creating 53, 54
displaying 58
editing 57
filter windows
arranging 43, 60
switching between 45
filters
combining 54-55
configuring 56
configuring parameter dialog access 74
invalid combinations 54
invisible 57
parameters 56
programming (see also programming) 133
renaming 57
valid combinations 55
firewall 38
frequency band 81
assigning a color 72
configuring 72, 113
frequency data 72, 78, 81, 110, 113-114, 137
frequency graph 91

G

gradient 121, 123, 125, 126
graph
configuring 71

H

Hamming window 92
Hanning window 92
high-cutoff filter 94

ICA component 102

ICA matrix 102

impedance view 50

individual channel mode 49, 92
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inhibition period 82-83, 98, 147, 148 (0]
installation
conditions (see also system requirements) 25 overlapping 91, 93, 119
Windows® Vista, Windows® 7 27
Windows® XP 26 P
K polarity 116
power density 79, 82, 92
keyboard shortcut 44, 45, 60 program
starting 39
L status 45
program folder 32, 58, 133, 136
license 25 program info'rmation
downloading 141 displaying 43

programming

installin -36, 142 i
i Ing 35-36, 14 interfaces 134

low-cutoff filter 94

LPT port RecViewlnterfaces.dll 133, 136, 138
controllin , 57, 81, 82-83, 96—98, 115-116, 1 sample filter 136, 137, 138
g 45, 57 3, 96-9 5 37 pulse (ECG)

identifying the address 145
programming example 138
specifying the address 40, 45
status display 137, 138 R
trigger 81, 96, 115

detecting 128

RDA server
M activating 37-38
Recorder 39, 77, 78, 84, 87, 89, 108, 116, 152
connectingto 39, 44, 48

Map 92, 110 C .
for segmented data 111 ?r:]sggg‘;:ccé';gofgzmsol}l},g 75289
marker , 87,
i i issi tionto 48
displaying 47 missing connec
for comments 84 monitoring mode 89
for peak 98 montage 75
RDA —38
for R-peak 116, 128, 131 sub-lsisgge 37631 o
hiding 130 36, 141-143

unblocking 38
rectification 78-79
reference channel 85, 129
ROI (Region of Interest) 103
channel 103
configuring 103-106
exporting 106
importing 106
R-peak 115, 116-117, 127, 129, 130, 131

segmenting on 118

setting 96, 97, 115
master filter 45

selecting 52
menu bar 43
Microsoft .NET Framework 29-30, 133
montage

keyboard shortcuts 76

showing 43, 45, 75

switching between 76
MR data 121 S
MR scanner 22, 115, 121

sampling interval 121
N sampling rate
reducing (see also downsampling) 124, 127

scaling 47, 67

configuring 67

individual scaling factors 68, 108

neurofeedback 81, 96
notch filter 94



ROl channel 108
scanner artifact 121, 125
correcting 121
segment
displaying 119
segmentation 118
status display 45
LPT port 82, 97, 115
sub-license (see also license) 141
system requirements 25

T

TCP/IP network connection 25, 38
template drift compensation 121-123
template drift detection 123, 125-126
test subject
requirements placed on 88, 90
threshold 82, 96, 97, 98, 116
time data 96, 110-112
Time of Repetition (TR) 121-124, 125
configuring 124
Time Zero marker 119
toolbar 43-45
topography 110
trigger 81, 82, 83, 96, 97, 98, 115
TTL pulse 45, 82-83, 97, 115, 147-149
TTL signal 82, 83, 97, 98

U

USB dongle 34, 36, 141
user account control 33

v

voltage difference 8g

w

window function
averaging 79-80
FFT 92
work files 39
folder 39, 75
workspace 43, 45, 62, 134
creating 62
loading 63-64
saving 63

4

zero padding 91
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